Physics 103/105 labs start Monday September 27, 2010. It's important that you go to the lab section that you signed up for. We will be expecting you!

You should have a lab book and a scientific calculator when you come to your first lab. (See details in the Orientation section following.)

Each week, before you come to lab:

- Read the procedure for that week's lab, and any additional reading required.
- The Prelab problems are optional, but please work them if it appears that they will be of help to you.

Also, for the first week:

- Read the “Orientation to Physics 103/105 Lab” and Appendices A and B.
# PHYSICS 103/105 LAB MANUAL

## Table of Contents

<table>
<thead>
<tr>
<th>Title</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Lab Schedule</td>
<td>iii</td>
</tr>
<tr>
<td>Orientation to Physics 103/105 lab</td>
<td>iv</td>
</tr>
<tr>
<td>Lab #1: Motion in Two Dimensions</td>
<td>1</td>
</tr>
<tr>
<td>Lab #2: Forces in Fluids</td>
<td>17</td>
</tr>
<tr>
<td>Lab #3: Collisions in Two Dimensions</td>
<td>23</td>
</tr>
<tr>
<td>Lab #4: Rolling Friction</td>
<td>29</td>
</tr>
<tr>
<td>Lab #5: Rotational Motion</td>
<td>35</td>
</tr>
<tr>
<td>Lab #6: A Precision Measurement of $g$</td>
<td>39</td>
</tr>
<tr>
<td>Lab #7: Coupled Pendula and Normal Modes</td>
<td>47</td>
</tr>
<tr>
<td>Lab #8: The Speed of Sound and Specific Heats of Gases</td>
<td>55</td>
</tr>
<tr>
<td>Appendix A: Data Analysis with Excel</td>
<td>65</td>
</tr>
<tr>
<td>Appendix B: Estimation of Errors</td>
<td>69</td>
</tr>
<tr>
<td>Appendix C: Standard Deviation of the Mean of $g$</td>
<td>75</td>
</tr>
<tr>
<td>Appendix D: Polynomial Regression</td>
<td>79</td>
</tr>
</tbody>
</table>
## LAB SCHEDULE

<table>
<thead>
<tr>
<th>Date</th>
<th>Topics</th>
<th>Experimentation</th>
<th>Equipment</th>
</tr>
</thead>
<tbody>
<tr>
<td>Sept 20-24</td>
<td>NO LAB</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Sept 27-30</td>
<td>Experiment # 1</td>
<td>Analyze motion of a bouncing ball, using VideoPoint and Excel.</td>
<td>PC &amp; CCD camera. Ball &amp; launcher</td>
</tr>
<tr>
<td></td>
<td>Motion in 2 Dimensions</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Oct 4-7</td>
<td>Experiment # 2</td>
<td>Forces in fluids and fluid flow</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Fluids</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Oct 11-14</td>
<td>Experiment # 3</td>
<td>Collisions in two dimensions</td>
<td>PC &amp; CCD camera</td>
</tr>
<tr>
<td></td>
<td>Collisions</td>
<td>Conservation laws</td>
<td>Air table, with pucks</td>
</tr>
<tr>
<td>Oct 18-20</td>
<td>Experiment # 4</td>
<td>Friction during constant acceleration on an inclined plane</td>
<td>PC &amp; CCD camera. Cart, tilted ramp</td>
</tr>
<tr>
<td></td>
<td>Friction</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Oct 25-29</td>
<td>NO LAB</td>
<td>--- MIDTERM EXAMS ---</td>
<td></td>
</tr>
<tr>
<td>Nov 1-4</td>
<td>NO LAB</td>
<td>--- MIDTERM BREAK ---</td>
<td></td>
</tr>
<tr>
<td>Nov 8-11</td>
<td>Experiment # 5</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Loop-the-Loop</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Nov 15-18</td>
<td>Experiment # 6</td>
<td>Use a precision pendulum to make an accurate measurement of $g$</td>
<td>Pendulum, photogate timer</td>
</tr>
<tr>
<td></td>
<td>Measurement of $g$</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Nov 22-25</td>
<td>NO LAB</td>
<td>--- THANKSGIVING ---</td>
<td></td>
</tr>
<tr>
<td>Nov 29-Dec 2</td>
<td>Experiment # 7</td>
<td>Study coupled motion of two pendula connected by a spring</td>
<td>Physical pendulum, spring</td>
</tr>
<tr>
<td></td>
<td>Coupled Pendula</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Dec 6-9</td>
<td>Experiment # 8</td>
<td>Measure the speed of sound, density, and specific heat of gasses.</td>
<td>Gas column, frequency generator, vacuum pump, scale.</td>
</tr>
<tr>
<td></td>
<td>Speed of Sound</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Dec 13-16</td>
<td>Make-up labs</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
Orientation to Physics 103/105 Lab

WELCOME TO PHYSICS 103/105 LAB!

Physics 103/105 labs start the SECOND full week of classes. It's important that you go to the lab section that you signed up for. We will be expecting you!

You should have a lab book and a scientific calculator when you come to your first lab. (See details in the Orientation section following.)

Each week, before you come to lab:

Read the procedure for that week's lab, and any additional reading required.

The Prelab problems are optional, but please work them if it appears that they will be of help to you.

Also, for the first week:

Read the "Orientation to Physics 103/105 Lab" material below.

I. What Physics 103/105 labs Are Like

You will soon find that Physics 103/105 Lab is not like any lab you've had before. You will be expected to think and be creative, not just follow instructions. The lab manuals for each experiment will step you through many of the new techniques that you will need, but you will not generally be given recipes to follow for each experiment. The manual for each week will typically describe a basic experiment that all students will be expected to complete. Beyond that, the manual will suggest a variety of additional experiments and extensions that you may find interesting and challenging. You can pick one or more of these to work on, or you can invent a new experiment on your own. The lab employs versatile equipment that will allow you to do the “standard” experiment quickly and then branch out to new challenges that match your interests and expertise.

In Physics 103/105 Lab, you will work in teams of two or three students. (Larger groups become unwieldy.) Your AI will randomly assign teams. Students may work in the same groups each week, but there will likely be changes in the groups during the term. Please be flexible about letting others work with you, or splitting up your existing team if it makes the groups more even. Your AI may mix reassign groups occasionally to give people a

I. What Physics 103 labs are like
II. Notebooks
III. Prelabs
IV. Grading
V. Attendance
VI. Feedback
chance to work with other individuals.

You will find that learning how to plan and work together will be crucial to the effectiveness of your team. Among your responsibilities in physics 103/105 is to be sure that all of the people in your team contribute to your success. Take turns performing the experiment and using the computer so that every team member gets a chance to “drive”. If one or more of your team members seems lost, take a few minutes to get them up to speed—you’ll need their input later when things get tougher! You will also find that you learn a lot by discussing problems with others, even when you think you’re the one doing the teaching. Most scientists and engineers today work in teams, some large and some small, depending on the size of the task.

Periodically, your AI will come by your lab bench and ask you questions about what’s going on. Of course, you can ask your AI questions about what’s going on too. You will find that your AI is a great resource. On the other hand, you shouldn’t be surprised if your AI doesn’t answer all of your questions directly. Your AI’s job is to help you learn, and sometimes the best way to do that is by making you struggle on your own for a while.

Sometimes, you will learn things in lab before you see them in lecture or precept. In other cases, you will see topics in lab that won’t be covered in the lecture at all. While physics labs are good for helping you solidify what you learn in lecture (either before or later), they are also great for going beyond the lecture, showing you additional techniques and phenomena that you won’t see in other parts of your physics course.

Among the important techniques you will learn in lab that won’t be covered in lecture are data analysis and error analysis (= analyzing the uncertainty in your measurements). These are critically important skills that you will need in your professional lives as scientists and engineers, and things you may not learn any place else. In many cases, estimating the uncertainty on your measurements will be the most difficult part of a lab.

The process you will go through in this lab closely approximates the working experience of professional scientists and engineers. It goes something like this: your team decides on an interesting investigation, makes a plan, organizes to do the work, gets and analyzes data, thinks about the results, and repeats or improves the experiment until you are satisfied with your accomplishments. The most valuable tool that you have in the lab (or anywhere else) is your common sense. A good scientist or engineer is always asking: Do we have a clear idea of what are we trying to do? Do our results so far make sense? Is there a better way to do it? Practicing scientists almost never get their final results the first time they do an experiment. Don’t just go through the motions: plan, think, and understand. Try to get to the result quickly, think about it, and then do a better experiment or try a variation to test a “what if?” idea. Along the way you will learn a lot of physics, especially if you are thinking and discussing (or arguing about) ideas with your teammates.
II. Notebooks

For physics 103/105 labs, you will not turn in any formal laboratory reports. Instead, you will be required to keep a notebook. You can get one at the U-Store. The spiral bound 5X5 QUADRILLE RULED (80 Sheets 11" X 8.5" Green tint) is recommended (cheap and adequate). If those are not available, try to get something close; quadrille paper is particularly important.

Start each week’s lab on a new page; write the date at the top, and who your other team members are. If you attend a different lab session than the one to which you are formally assign, also write your formal lab section. From that point on, your notebook should be a comprehensive record of everything you do and think in 103/105 lab that day; sort of like a diary or a journal.

Your lab notebook is not the same as a “lab report.” It contains similar information, but in much less polished form. DO NOT waste time making your notebook look pretty. It should be neat enough to be easily understandable, BUT NOT NEATER. Feel free to cross things out, draw arrows, make freehand sketches, and cuss. Use scissors and tape to include printouts in your notebook whenever you use a computer to make a diagram or a graph. Also, include all of the things you tried that didn’t work out how you planned; they’re an important part of what you are learning too. Just be sure that your notebook is easily readable, and always take some time to write some understandable sentences explaining what you are about to do, what you’ve just done, and what you have learned from it.

Suppose, for instance, that you have just measured the speed of a car that has rolled down a ramp, and it didn’t come out like you expected it to. You might write:

“The value we came up with for the speed of the car was 4.2 m/sec; that’s about 15% lower than we expected. Maybe friction (while rolling) is more important than we thought? Jen suggested we try raising the ramp: that way the speed of the car should be greater, and the effect of friction should be (relatively) smaller.”

You could then try the experiment again, including the new data and a new graph in your notebook, along with your conclusions:

“Dang! The speed increased to 6.7 m/sec, but now that’s 25% lower than we expected it. The problem didn’t get better, it got worse! So much for that idea: we can conclude that friction while rolling down the ramp probably isn’t the problem....”

Notice that although the problem isn’t solved yet, the student was able to draw a partial conclusion: that the discrepancy in speed is not due to rolling friction. These conclusions are vital for your notebook. Without them, your notebook is just a bunch of meaningless numbers. Of course, a final paper based on this experiment might never include this degree of detail, especially about this part of the experiment that seems to be producing inconsistent results. But solving these difficulties is an important part of your experience in lab, and your description of your experience is what your notebook is all about.
Students are often unsure about how much detail to put in the notebook. What we most want to see in your notebooks is evidence of thinking, and not just “correct” results.

At the end of your lab period, leave your notebook on the shelf in your lab room for your AI to grade. DO NOT REMOVE your notebook from the lab room. This rule is for your own benefit. When students take their notebooks home, it starts a sort of arms race for who has the prettiest colored graphs and the best spelling. Don’t waste time beautifying your notebook; it's a record, not an artwork.

Professional researchers rely heavily on their notebooks for reference when they write the papers or reports describing their work. Notebooks are the means to recall and check, sometimes years later, what went on in the lab. Many researchers have their notebooks regularly notarized, in case they are needed for patent verification. It's important to learn how to keep a good lab notebook. Someday your job may depend on it.

III. Prelab work

Please read (and think about) the lab instructions before coming to lab. Otherwise you will waste a lot of time in getting up to speed. If your lab partners aren’t reading the write-ups ahead of time, ask them to do so. Many of the writeups refer you to Appendix materials which you will be expected to read carefully.

You can also complete the optional “prelab problems” at the end of each set of lab instructions before coming to lab. The prelab problems are not too hard or time consuming, but they can be helpful in getting you prepared for each week’s material.

IV. Grading

The main intent of Physics 103/105 lab is to offer you a chance to be scientifically and technically creative. We want you to form and pursue ideas. Our evaluation of your work will depend a lot on your creativity and understanding, and very little on “getting the right answer.” Experimentation is hard, and even good experiments don’t always turn out how you plan them to be.

Golden rule of 103/105 lab grading: In general, we won’t hold it against you if an experiment doesn’t produce the answer you think it should or doesn’t quite get finished, as long as you worked hard and were intellectually and creatively engaged for your entire lab period. The flip side of the pact is this: In general, you are required to be intellectually and creatively engaged for your entire lab period, even if your experiment goes well. If you finish one experiment, then think of another.

Whatever you do, don’t just sit around doing nothing. Your grade will suffer, and you will attract unwanted attention.
For Physics 103, the Lab grade is worth 15% of your course grade in the class (Physics 105 will announce its grading scheme in class). But for both classes, your lab grade is calculated as follows:

75% Notebooks: Graded after each lab for completeness, thoughtfulness, and readability.
25% Participation: Graded for each lab for creativity and industry.

V. Attendance

Attendance each week is vital in Physics 103/105 Lab. If you must miss your regular lab section due to illness, University-related travel, or religious reasons, contact the Ph103 Lab Manager: Prof. Kirk McDonald (kirkmcd@princeton.edu) by email to arrange to go to another lab section.

Not Completing one lab will lower your PHY 103/105 course grade by one full letter grade. Not Completing two labs will result in automatic failure of the entire course.

If you realize that you have missed a lab because you have slept through it or have forgotten what day it was, then you can make it up later that week in another lab section. If you realize you have missed your lab, try to contact Prof. McDonald. However, if you have only one time slot left that you can make up the laboratory, don’t wait to hear from the department office; just show up, explain the situation to the AI, and we’ll sort the paperwork out later.

Makeup labs will offered, by appointment with Prof. McDonald, during the last full week of class, Dec. 13-17. However, it is strongly recommended that in case of schedule difficulties some week, you attend some lab session that week, and work with other students on the lab.

VI. Feedback

Physics 103/105 Labs are always changing. As always, we think we’ve nailed it, but chances are we’ve missed some things. To help us do better in future weeks and future years, we want to hear feedback from you.

If you have any questions, comments, or concerns about Physics 103/105 Lab, please bring them up with your AI, the lab manager, or the course head. Thanks!

Physics 103/105 Labs start on Monday, September 27, 2010. See you there!
LAB #1: Motion in Two Dimensions

BEFORE YOU COME TO LAB:

1. Read the Orientation to Physics 103/105 lab, above.
2. Read the Introduction and Physics Background sections, below.
3. If you are unfamiliar with spreadsheet programs, read Appendix A – Data Analysis with Excel
4. If you find it helpful, work the optional PreLab problem set attached at the end; You can discuss this with your AI at the beginning of the lab.

This lab is about motion, and how to describe it. The intuitive precision that a baseball player shows in moving to exactly the right location to catch a fly ball immediately after it leaves the bat is amazing. But in the technical realm it is useful to make a mathematical description. Describing motion requires measuring position and time. In Galileo's era, a measurement-based approach was in its infancy. But it is fundamental to all science.

Much of your time in this lab will be spent mastering a video-based method of measuring position and time. But don't lose sight of what is really important – characterizing motion itself. In what sense does motion sustain itself, and how do external agents affect it? Can two-dimensional motion be analyzed in terms of two separate descriptions, each involving only one dimension? Newton's simple equation, $F = m \ a$ (with $F$ and $a$ being vectors), underlies a formal answer to such questions. But formalism has to be related to measurement and intuition. That is what this lab is really about.
A. Introduction

In this lab you will use a video camera to make videos of moving objects, and a computer to analyze the motion. It is important that every member of your group learn how to use the computer and software. Be sure that you all take turns and that, when you are the operator, your partners understand what you are doing.

The programs that you will use can be activated by clicking on icons on your computer's Desktop. These include:

- **VideoPoint Capture**: We use this to record a video.

- **VideoPoint**: the program in which you will analyze your videos, by measuring positions in the video frames, and graphing and analyzing the results.

- **Excel 2003 (with WPTools)**: an extension of the common Excel spreadsheet program, which allows more detailed calculations and graphing. The WP (Workshop Physics) extensions make it easy to use Excel's sophisticated graphing functions.

- **Student Data**: a folder with space for you to put your files.

- **Word 2003**: which can be used for note taking, and printing camera images.

The folder **Worksheets and Tools** will not be needed in this lab.

Capturing a Single Still Image

Your first task is to capture a still picture of yourself to give to your lab instructor to help him or her remember your name and face.

1. Open **VideoPoint Capture**. A window pops up labeled **Choose Capture File**. The default file name is **capture**. Simply click **Save** to go to the next step.

2. A window labeled **Preview** appears, which displays whatever your camera is viewing at the moment. Wave a hand in front of the camera. The focus and iris settings of the lens should not have to be changed. Notify your AI if you believe that these settings are incorrect.

3. Position yourselves (re-aiming the camera if necessary) so that your faces fill the screen. Then reach over, hold down the **ALT** key, and hit the **Print Screen** button near the right end of the top row of keys on your keyboard. (This actually makes a copy of the screen, rather than printing anything.)

4. Now, open **Word 2003**. Click on **Edit → Paste** (upper left corner) to insert the image that was copied using the **Print Screen** command. (Please do NOT
change any of the computer or display settings in an attempt to make the image larger. Such changes may interfere with your analysis program.) Type your names below the image.

5. Click on File → Print icon on the top bar of Word to print your picture on one of the two Dell printers in the center of the Lab room. Each member of your team should include this picture in your Lab notebook. (Extra copies to take home, or to send your grandmother, are allowed.)

Stop and Think – What is a digital image?

Before trying to capture a video in the computer, let’s be sure that we understand what the moving image on a television screen actually consists of. It is a series of individual stationary, or still, pictures, appearing at a rate of 30 pictures, or frames, a second. Standard movie films consist of strips of such still pictures, recorded photographically at a slightly lower frame rate.

Digital computers, and hence our electronic imaging systems, work only in quantized units. Your camera divides the area that it sees into 307,200 pixels, arranged into a grid 640 cells wide by 480 cells high. You will see later that VideoPoint measures x- and y-positions with twice this resolution, dividing the x-direction into 640 integer steps and the y-direction into 480 steps. In either case, a 1-step by 1-step cell is called a pixel, for “picture element.”

To determine the coordinates of an object in an image frame using VideoPoint, we just position the cursor over the object, and the system will count the pixel rows and columns to get to the location of the cursor, starting at the lower left of the image on the screen. Then, if we know how many pixels correspond to a meter long object, we can calculate real distances from the pixel counts. This is called “scaling the image.” We will return to this shortly.

With real distances known from scaling the images, and with the time interval between two chosen frames also known (a multiple of 1/30 sec, say), we can easily calculate such things as velocities and accelerations of moving objects in our videos.

Note that the system reports locations rounded to the nearest integer pixel count. As a result, no position measurement can be known more accurately than within ± 0.5 pixel spacing, or to within ± 1/2 of whatever distance is equivalent to one pixel in real units (mm, meters, etc.).

B. Physics Background

In this Lab you will analyze the trajectory of a bouncing ball. The ball will be accelerated by gravity in the –y direction, but not in the x direction. Assuming that only gravitational forces are significant, the ball's motion should obey the equations
\[ x = x_0 + v_{0x}t , \quad (1) \]
\[ y = y_0 + v_{0y}t - \frac{1}{2} gt^2 , \quad (2) \]
\[ y = y_0 - x_0 \frac{v_{0y}}{v_{0x}} - \frac{g}{2} \frac{x_0^2}{v_{0x}^2} + x \left( \frac{v_{0y}}{v_{0x}} + \frac{g}{2} \frac{x_0}{v_{0x}^2} \right) - \frac{g}{2} \frac{x^2}{v_{0x}^2} . \quad (3) \]

In this experiment, a golf ball rolls down a fixed rail (the “launcher”). After it leaves the launcher it falls freely, bouncing at least twice on the table top. The camera takes a series of pictures at fixed time intervals between the first and second bounces, when the ball is moving freely. By measuring the position of the ball in each picture, you can test equations (1) and (2).

C. Acquiring the Data

Open VideoPoint Capture and use the Preview Screen to

1. Aim the camera, and check the lens focus and aperture setting.
2. Get a meter stick from the center of the room, and place it with its support bracket against the black backdrop. Verify that the launching rail is the same distance from the backdrop as is the meter stick. Remove the meter stick.
3. Make a few trial runs, adjusting the launcher as necessary for the camera to catch one full bounce.
4. Set the frame rate to 30 frames per second, using Edit → Preferences → Capture Settings. Then, in the tab Output Settings, be sure the box next to Re-Compress When Saving is NOT checked. You must do this each time you (re)open VideoPoint Capture.
Make an Actual Movie of the Bouncing Ball

1. Start recording by clicking on the Record button.
2. Start the ball rolling down the launcher, and let it complete one full bounce.
3. Hit the Esc button on your keyboard to stop recording. (The Stop button on the screen doesn't always stop the recording quickly.)
4. Note: Although you don't need to rush things, don't record too much “dead air” before and after the actual experiment – it just ties up computer memory.
5. If you need to remake your video, click on the File menu (upper left) and then on New Capture (and don’t Keep/Save the bad video). Or, click the <<Record button in the lower left. Or, you can quit and restart VideoPoint Capture.

Viewing Your Video

After VideoPoint Capture takes a few seconds to organize your video, it displays the first frame of your movie in an EDITING window. Note that you can:

1. Play the movie by clicking on the little triangle at the lower left. Watch the progress as indicated by the moving “progress button” below the image. (Clicking on the triangle while the movie is playing will stop it at whatever frame it has reached.)
2. Jump to any frame by manually moving the progress button with your cursor.
3. Single-step from one frame to the next by clicking on the left- and right-arrow buttons in the lower right corner.
Each of you should spend some time playing with the editing screen controls, to understand their functions and to get a “feel” for the fact that a video or movie is really only a sequence of still pictures.

**Editing Your Video**

In general, your original video will contain more frames than you will want to use for analysis. Today, we want to analyze the ball's motion only between two consecutive bounces off the table.

To get rid of the unnecessary frames at the beginning and end of your video:

1. Use the progress and single-step buttons to choose the first frame after the ball has bounced from the table.
2. Click on the First button. All of the earlier frames are eliminated.
3. Move the video back to the last frame before the ball bounces again. Then click on Last. All of the later frames are eliminated, and your video contains just one bounce.
4. Click on Keep to save the file (or click on File, and then New Capture to discard the data and record a new movie).

**Naming and Saving Your VideoPoint Capture File**

There is a folder called Student Data on your Desktop in which you should store all of your data and analysis files.

To save your video,

1. Click on the Save button on the editing screen.
2. Enter a name with a .mov extension in the window Save Movie File as.
3. Click Save.
4. You are done with the program VideoPoint Capture for now. If you Exit and restart it later, you will have to reinitialize the frame rate and uncheck the Re-Compress box.
D. Digitizing the Ball’s Trajectory Using VideoPoint

Click the VideoPoint icon on your Desktop to open this program. If you see an information screen titled About VideoPoint, just click on the little x at the top right to make it disappear. One the next popup window, click Open Movie, and click on the movie that you saved in Student Data. In the Number of Points window which then appears, click OK to 1, since there is only one object that we want to analyze (the bouncing ball).

Your movie should now appear in a VideoPoint window, that shows the first frame of your edited video, with your file name appearing in its title bar. Two other windows pop up also, Table and Coordinate Systems, which may be behind the movie window. The movie window shows one frame at a time, whose number, and the total number of frames are given in the upper right corner.

Confirm that you can step through your movie, using the double arrows at the lower right. If the ball is not visible in all frames, or the movie includes more than a single arch, you should go back and make a new movie.

Digitizing Coordinates of the Bouncing Ball

The movie window is where you will "pick off" the coordinates of the golf ball's position in each frame. Note the yellow coordinate axes on the screen, and note that the cursor changes to a cross-hair pointing device when you move it into the image area. Finally, note that both the time of the frame and the x- and y-coordinates of the cursor are shown at the lower left of the movie window (with even values, equal to twice the pixel coordinates).
To record your positional data,

1. Go to the first frame of your edited movie.
2. Position the cursor over the image of the golf ball, and click your left mouse button.
3. Note that the movie advances automatically to the next frame. (If it doesn't, go to the Options menu and put a check mark next to the Auto Frame Advance option.)
4. Click on the image of the golf ball for several more frames. Pause to turn on the Edit → Leave/Hide Trails option, and note that all the point that you have digitized are now shown, as well as all frames being superimposed.
5. Continue clicking on the image of the golf ball until you have recorded its position in all frames of your movie.
6. If you made a mistake in positioning your mouse in a particular frame, you may want to correct this. Go to the Coordinate Systems window and highlight the row labeled Point S1. This changes the symbol of the digitized point in the active frame to two concentric circles. *If this is not the point you wish to change, go to the frame that contains the point in question.* Then, while holding down the left button on the mouse, move the location circle to the new, corrected, position. Releasing the mouse button completes the change, and enters the corrected coordinates into the data table. *It may be easier to first move the cursor to a very “wrong” position, and then make the “right” measurement.*

The Table window now contains a list of your digitized points. It is prudent to save your work via File → Save As) to Student Data. VideoPoint will create a .vpt file for this.

**Summary of Options When Picking Off Coordinates:**

- Note that the Movie cursor looks like a crosshair if no coordinate has been chosen for a given frame, and like an arrow otherwise.
- Use Edit/Leave or Hide Trails to turn trails on or off.
- Use the Coordinate System window to Select a point series by highlighting it.
- Move a selected point in a given frame, by positioning the tip of the arrow on the point and holding down the left button.

VideoPoint includes various options for graphing and fitting curves to data. While you are free to try these out, we recommend using Excel for this purpose. The Appendix gives advice on how VideoPoint could be used instead.

**E. Using Excel for the Data Analysis**

Spreadsheet programs are powerful tools for data analysis, in finance and other fields as well as in science and engineering. Our version, Excel 2003 with includes extensions generated by an academic project, Workshop Physics (WP), to allow easier generation of graphs from spreadsheet data.
Start Excel to obtain a new, blank worksheet. To transfer your digitized data from VideoPoint, you will “cut and paste”. Back in VideoPoint, highlight all the data in the time column, and click Edit → Copy Data. In Excel, right click on cell A2, and then click on Paste. Type a column label in cell A1. This label will later appear on your plots.

Similarly, highlight the two columns of your x and y data in the VideoPoint Table, then right click on cell B2 and click Paste. Add column labels in cells B1 and C1.

To make a graph in Excel with WPTools, you have to identify what you want plotted:

1. First, “swipe” your cursor across the data you want to plot on the horizontal axis. (For example, swipe across the time values.)
2. Then, while holding down the Ctrl key, swipe across the corresponding data you want for the vertical axis (say, the y values).
3. In the WP Standard bar click on the Scatter Plot icon to generate the plot.

A window should appear on your .xls sheet showing a plot of y vs. t. Create plots of x vs. t and y vs. x in the same manner. These plots use your column labels.

You can now address the main issue of this Lab: does the bouncing golf ball obey equations (1)-(3). To do this, you will fit curves to your graphs, and thereby determine experimental values for \( x_0, y_0, v_{0x}, v_{0y} \) and g, as well as estimates of the accuracy of these measurements.

First consider eq. (1) using your plot of x vs. t. This is a linear equation, but it’s best to try a quadratic fit to learn if the data is actually linear.

1. Click on one of the data points of your x vs. t graph, to select and highlight the points plotted.
2. Click the Polynomial Fit icon in the WP Standard bar and choose Order 2 to create the fitted function. We recommend that you choose the order to be one higher than that you believe describes that data: thus, choose order 2 for supposedly linear data. Several boxes describing the fit should appear on your graph window. [If not, go to WPTools / Preferences and make sure that the options for displaying fit equations and statistics on the plot are both checked. If not, check them, and redo the plot.]
3. The parameters of the fit are
   \[
   a_0 = \text{the constant term in the quadratic equation}
   \]
   \[
   a_1 = \text{the multiplier for } t \text{ in the equation}
   \]
   \[
   a_2 = \text{the multiplier for } t^2.
   \]
4. Note the value for $\sigma$ (lower-case Greek letter sigma). This is the computer's estimate for how far a typical data point deviates from the fitted curve.

Does the value of $\sigma$ seem reasonable? You should comment on the magnitude of the typical deviations, and on possible causes, in your notebook. If $\sigma$ is too large, you should redigitize your images, or take a new movie.

5. Note also the values for SE($a_0$), SE($a_1$), and SE($a_2$). These are values of what are called the "standard errors" in the values which the computer calculated for $a_0$, $a_1$, and $a_2$. These are the computer's estimates for how precisely your data determine the fit parameters, given the "jitter" of the data about the curve. A discussion of the algorithm used to make these standard error estimate is given in Appendix D of the Lab Manual.

6. You can consider Excel's value for $a_1$ and SE($a_1$) to be your physics result for the value of $v_{ox}$ and the estimated error in that value (still in units of pixels/sec, of course, since you haven't yet converted pixels to meters.) Record your result for $v_{ox}$ in your lab book, and calculate the relative precision, SE($a_1$) / $a_1$.

Make similar analyses of your plots of $y$ vs. $t$ and $y$ vs. $x$, using polynomial fits of order 3 since the physics expectation is that these data should be quadratic functions. Of particular interest are the values (and error estimates) of parameters $a_2$ from these fits, since they are proportional to the acceleration $g$ of gravity, according to equations (2) and (3).

**A Common Problem**

Did your graph of $x$ vs. $t$ have some curvature, rather than looking like a straight line as implied by eq. (1)? A common reason for this is that the plane of the trajectory of the golf ball was not perpendicular to the optical axis of the camera.

If the horizontal angle between the optical axis and the perpendicular to the plane of the trajectory is $\theta_x$ in radians, then the coefficient $a_2$ in your fit to $x$ vs. $t$ is approximately

$$a_2 \approx \frac{v_{0x}^2 \theta_x}{D},$$

where $D$ is the distance from the camera (focal plane) to the plane of the trajectory. A consequence of this is that your measurement of $g$ via the $y$ vs. $t$ plot has a systematic error roughly given by

$$\frac{\Delta g}{g} \approx \theta_x \left(1 - \frac{2v_{0x}v_{0y}}{gD}\right).$$

This effect could well be a major source of error in your measurement of $g$, so you may wish to make new movies of the bouncing ball until you get one with a "small" value of $\theta_x$.

**Interlude**
Before we convert pixels to meters and get our final physical result for the value of $g$ and its uncertainty, let's review some of the concepts we have used.

1. Things are accelerated by gravity in the vertical direction, but not horizontally.

2. Constant acceleration leads to a quadratic variation in position.

3. An electronic camera can measure positions in pixels, which have later to be converted to meters. The integer-pixel position measurement leads to an uncertainty of $\pm 0.5$ pixel in our knowledge of the true position (and VideoPoint multiples all pixel values by 2).

4. Every individual measurement is inexact, and we need to understand what a typical uncertainty in a measured quantity might be.

5. Our result for the value of $g$ (in pixels/sec$^2$) is inexact, because the measurements are inexact.

Our focus on the deviations of measured points from the fitted line assumes that the fit itself is our best measure of the true function, and that the deviations are due to random jitter in the individual measurements. However, other types of errors, called systematic errors, can affect all of your measurements in a similar manner. An example occurs when you convert pixels to meters. The conversion factor clearly affects all of your points at once.

F. Scaling the Pixels

We have now to determine how many pixels in our picture correspond to one meter in the real world. We will do this by measuring how long a meter stick was in our video, as measured in pixels. The resulting value for our conversion factor (pixels per meter, or the inverse, meters per pixel) will allow us to convert any measurement from pixels to meters (or pixels/sec to meters/sec, etc.).

Our conversion factor will have some error, which we can estimate based on the pixel quantization error, plus a “guesstimate” as to how reproducibly we can position our cursor on the ends of the meter stick. Once we know the conversion factor, and its estimated error, we can use it to convert all of our measured $x$- and $y$-positions to meters from the origin, rather than pixels. But the conversions will all involve the factor, which has some error associated. This is a systematic error, since it affects all measurements equally.

If VideoPoint Capture is not still running, restart it (and remember to initialize the frame rate and uncheck the Re-Compress box). Take a short movie with the meter stick vertical in the center of the frame, and another with it horizontal. Remember to place the meter stick as far from the backdrop as is the launcher rail.

Use VideoPoint to analyze these movies. Move the cursor manually to either end of the meter stick (or the 10- and 90-cm positions), and note the pixel coordinates at the two position, from the live display at the lower left corner of the movie screen. Calculate the
distance between the two points, in pixels. Using the distance in pixels, calculate your movie’s scale factor, $F_x$ (or $F_y$), in units of pixels per meter. Use this to convert the relevant fit values from your three plots into meters (or m/s, or m/s$^2$, etc.) to deduce the acceleration of the golf ball in m/sec$^2$ by two methods. Note the result in your lab book.

*Are your answers close to the expected value of $g$?* What effects might systematically bias your answer away from 9.8 m/s$^2$?

Now let's consider what is the accuracy with which your measurements determine a value for $g$. If the uncertainty in $g$ is called $\Delta g$, then the fractional, or relative, uncertainty in $g$ is defined as $\Delta g/g$.

When you estimate the uncertainty in your determination of $g$, you should use both the computer’s estimate of the effects of random errors, $SE(2)$, and your estimate of the uncertainty in the conversion factor $F_x$ and $F_y$ from pixels to meters. That is, for the measurement using the $y$ vs. $t$ data,

$$\frac{\Delta g}{g} = \sqrt{\left(\frac{SE(a_2)}{a_2}\right)^2 + \left(\frac{\Delta F_y}{F_y}\right)^2},$$

where $F_y$ is your $y$ scale factor. It is up to you to estimate a value for $\Delta F_x$ and $\Delta F_y$ perhaps by repeated trials. Taking responsibility for estimating the accuracy with which you make a measurement is not easy, but you have to do it. Take time to think it through!

Similarly, the estimate for the relative uncertainty on $v_{0x}$ as determined from the $x$ vs. $t$ plot is

$$\frac{\Delta v_{0x}}{v_{0x}} = \sqrt{\left(\frac{SE(a_1)}{a_1}\right)^2 + \left(\frac{\Delta F_x}{F_x}\right)^2},$$

and the relative uncertainty on $g$ as determined from the plot of $y$ vs. $x$ is

$$\frac{\Delta g}{g} = \sqrt{\left(\frac{SE(a_2)}{a_2}\right)^2 + 4\left(\frac{\Delta v_{0x}}{v_{0x}}\right)^2}.$$

Some discussion of the calculus of propagation of errors is given in Appendix B.8 of the Lab Manual.

**Record your final results for $g$ and for $\Delta g$.**

Note any comments you might have on the reliability of your conclusions, and on a comparison of your results with the accepted value for $g$, namely 9.80 m/sec$^2$. 
Appendix: Using VideoPoint for Data Analysis

Graphing Your Data

To use VideoPoint to make graphs, first click on the View → New Graph menu item. For each graph, you must tell the system which variable you want plotted on the x-axis, and which on the y-axis. Normally, you will want either time or x-position to run horizontally, and x- or y-position, velocity, or acceleration to run vertically.

Let's make and print out some graphs. Start with an XY graph. Choose Point S1 / x / Position for the Horizontal Axis, and S1 / y / Position for the vertical axis. Note that, if you go back to the Movie window and advance through the frames, a circle moves on the graph to indicate which of the points plotted corresponds to the movie frame currently visible.

To print a graph, first make its screen active by clicking anywhere on it. (The title bar of the graph will be colored blue after your click.) Then click on the File → Print menu bar option, and click on Print and OK when you are asked to confirm your request. If you maximize the size of the graph window before printing, your printed graph will be larger.

You can also make a printout of any one of the frames of your video, simply by printing when the movie window is selected.

If you need a printout of your data table, first be sure to first maximize the table window by clicking on the middle one of the three boxes at the right end of the Table title bar. Then issue the print commands. When you want to make the table small again, just click on the middle box, as before. (If your table is very long, you may have to print more than one time, scrolling vertically to change which data lines are presented each time.)

Physics Discussion

Print out and think about the following graphs. Each of you should have your own copy of the group's printouts, and note your own conclusions on your own plots.

1. Do the plots of x-position, velocity, and acceleration all confirm that the golf ball is subject to no horizontal force?
2. Does a plot of y-position vs. time look like you expected? (What is that?)
3. What does a plot of y-velocity vs. time look like? What does that show?
4. What about a plot of $y$-acceleration vs. time?

You should know that we expect to see a constant, negative, acceleration of the golf ball in the $y$-direction. Numerically, we expect that the acceleration of the golf ball will be $g$, which is approximately equal to 9.80 m/sec$^2$. But we have yet to scale our movie, in order to find the conversion factor between pixels and meters.

Before we scale the movie, let's look at our results in terms of pixels, and take a look at how accurate those results seem to be.

**Final Analysis – Fitting Your Data; Looking at Data "Jitter"**

Now for some more quantitative analysis. First, let's fit a quadratic curve to $y$ as a function of time. The computer can show us the quadratic function that "comes closest" to passing through all of the data points on our $y$ vs. $t$ plot.

To do this, go to your graph of $y$-position vs. time, and then click on the red F (for Fit) button near the upper right hand corner. A dialog box will appear. Select the Polynomial option, and then choose Order 2, and click on Apply. VideoPoint's best-fit line should appear on the graph.

At the top of the graph is the algebraic function resulting from the plotted fit. (Here, $x$ refers to whatever is the horizontal variable on the graph, not to our $x$ coordinate. Also, you should ignore the computer's $R^2$ (R-squared) parameter. It is simply one of several statistical measure of the goodness of the fit, and VideoPoint often calculates it incorrectly.)

The number multiplying the squared term in the fit corresponds to the "$1/2 g$" factor in equation (2). If we multiply our number by 2, that gives our experimental value for $g$, in units of pixels/sec$^2$.

Before moving on to scale the movie, and get $g$ in m/sec$^2$, let's look at how closely our data follows the computer's "best fit" curve.

**Zooming in VideoPoint; Looking at Data “Jitter”**

Maximize your plot of $y$ vs. $t$. Probably all of the points lie close to the curve, but how close? "Magnify" a region of your VideoPoint plot, by “zooming in” on it with the following steps:
5. While holding down the Ctrl (Control) key of your keyboard, hold down on the left mouse button and use the cursor to draw a rectangular box around a region of interest containing one of your data points. The graph then shows only that region, in a magnified view.

6. If you want to magnify some more, do it again. (But if you magnify too much, the fit line may disappear, and you'll have to start over by returning to the unmagnified graph.)

7. When you want to return to your original unmagnified view, just hold down on the Ctrl key and double-click with the left button of your mouse.

Use the zooming feature to look at several points of your graph, and to judge how far the points are vertically away from the best-fit curve. **Record your results, and calculate the average of the magnitudes of the deviations that you found.** [WARNING – after a “zoom,” the scales on VideoPoint's graphs may not be quite what they seem. Often, there is an additional decimal place which is not shown on the screen's axis labels. To correct this, you can double-click on the axis, and delete the extra digit to cure the problem. For now, it is easier to use the cursor readout at the lower left corner of the graph to estimate the differences between your data point and the nearby curve.]

The average deviation which you have calculated is an estimate for how much an individual measurement varies from the “true” value indicated by the curve. It includes the random ± 0.5 pixel “quantization error,” plus any inaccuracies you introduced in picking off your points.

**Storing Your VideoPoint File**

First, click on File → Save As in the VideoPoint menu bar. As before, use the up arrow and double-clicking to cause your section’s folder identification to appear in the Save in: box at the top of the dialog box which appears. It will be convenient to use the same name as the one you gave the video file which you saved at the end of the VideoPoint Capture activities. This name should be visible at the top of the movie screen, if you have forgotten it.

If you use **Windows Explorer** to look at the contents of your section’s data folder, you will see that there are actually three files associated with any movie that you have analyzed. A large file with the extension .mov contains the actual movie. A small file, having the same name with the extension .mov.#res added comes along with the movie file. The VideoPoint file .vpt is also a small one. It has whatever name you gave it, but can be used only if the movie file is also available on your computer.
1. Assume that in a digital image there are 600 lines and 800 columns (typical for some computer display screens). Each point in the image lying at the intersection of a line and a column is called a picture element, or “pixel.” Each pixel has its own brightness and color. The intensity of each of the three primary colors at each pixel may be described by an integer number, lying between 0 and 255. Each number takes 8 digital bits, or 1 “byte,” to define.

(a) How many pixels are there in the image?

(b) How many bytes of computer memory are required to record the image?

(c) If a video or movie consists of a series of 30 such images every second, how many bytes of information must be transmitted every second in order to display the movie? How many bits per second? (This is what sets the electrical engineer's design specification for a television system.)

2. Isaac Newton is said to have considered the motion of an apple falling from the tree in thinking about gravitational forces. If we look at the apple's vertical motion, starting from the instant when it is released from rest, the distance it falls increases with time according to the formula for uniform acceleration,

\[ s = \frac{1}{2} g t^2. \]

Galileo, who died the year Newton was born, studied motion under uniform acceleration, but did not have Newton's mathematics. He concluded that

Starting from rest, distances traveled in successive equal increments of time are in the proportions 1 : 3 : 5 : 7 : .........

(a) Using the formula \( s = \frac{1}{2} g t^2 \), calculate the vertical distances traveled by a ball falling from rest after 0.1, 0.2, 0.3, 0.4, and 0.5 seconds. (To honor Newton's heritage, let's use English units and take \( g = 32 \text{ ft} / \text{sec}^2 \).)

(b) Show that your results are consistent with Galileo's description.

If you are intrigued by this result, you might want to prove that Newton's result produces Galileo's rule, for any set of equal time increments. Hint: think about the quantity \( [(N + 1) \Delta T]^2 - [N \Delta T]^2 \).
LAB #2: Forces in Fluids

Overview Comments:

In this lab, you will explore some basic effects of forces in fluids: viscous (frictional) forces, as well as the buoyant force.

Although the behavior of fluids is rather complicated in general, fluid motion obeys Newton’s laws. A small element of fluid can be characterized by its volume, mass, and characteristic position, velocity and acceleration. But, the volume can change its shape, and in the case of compressible fluids, its magnitude can change as well.

In the first two parts of the Lab, you will consider an incompressible fluid, heavy machine oil, that is very viscous, and in the third part you will consider a compressible fluid, a gas, but at constant pressure so that its volume does not change.

Do you know that a cubic meter of air weighs almost three pounds? No wonder it takes strength to hold your arm out the window of a moving car – it takes force to make all that air get out of the way!

I. Flow of a Viscous Fluid in a Circular Pipe

It is a remarkable fact that fluid immediately adjacent to an immobile surface, such as the wall of a pipe, always has zero velocity. In order for fluid some distance $y$ from the surface to flow at velocity $v$, a force must be applied:

$$F = \frac{\eta A v}{y}$$

where $A$ is the area of the surface (or, equivalently, the area of the layer of fluid), and $\eta$ is the coefficient of viscosity. Fluid flow through a circular pipe is slightly more
complicated. Poiseuille's law states that for a circular pipe of radius $R$ and length $L$, the pressure difference $\Delta P = \Delta F / A$ (where $A = \pi R^2$) between the two ends of the pipe required to maintain an average velocity $\bar{v}$ is of the fluid flow over the cross section of the pipe is related by

$$\Delta F = A\Delta P = \frac{4\eta A'\bar{v}}{R},$$

or equivalently,

$$Q = A\bar{v} = \frac{\pi R^4 \Delta P}{8 \eta L},$$

where, $A' = 2\pi RL$ is the surface area of the pipe, and $Q$ is the volume rate of fluid flow. The $R^4$ dependence of $Q$ is impressive (and implies that your heart must work very hard to pump blood through your arteries if they "clog up" even a little).

![Figure 1: Apparatus for parts I and II of the Lab. The vertical cylinder is partly filled with oil. It is open to the atmosphere at the top.](image)

**Specific Instructions:**

Use the apparatus shown in Figure 1 to test Poiseuille's law and to measure the viscosity of a fluid. The fluid is heavy machine oil, which fills the large vertical cylinder. Its weight produces the pressure at the bottom of the cylinder and, therefore, at one end of the small horizontal tube. The other end of the horizontal tube is at atmospheric pressure. Thus the pressure difference across the length of the small tube is $\Delta P = \rho g h$, where $h$ is the height of the fluid above the tube.

Find the density of the oil using a scale and a graduated cylinder.
Measure the flow rate in each of the three available tubes (radii 0.319, 0.239 and 0.216 cm), using a stopwatch and a graduated cylinder.

Hints: Keep the small tube horizontal to minimize the effect of gravity on the flow. Measure the height of the fluid in the vertical cylinder before and after the oil flows out, and use the average value. From which point should the height be measured?

**Analysis:**

First use your data to test the assertion that $Q$ is proportional to $R^4$. Although it isn't strictly true, assume that each tube has the same length $L$. Then you can reformulate Poiseuille’s equation as:

$$Q = \text{Constant} \times R^\alpha$$

Analyze your data to determine the exponent $\alpha$.

Do this two ways, both using Excel.

After entering your data for $R$ and $Q$, make a scatter plot of this using WPTools. Click on the horizontal axis, and then and Format Axis → Scale to check the box Logarithmic scale. Then, do the same for the vertical axis. This converts your plot to a log-log plot. On a printout of this plot, draw a “best fit” straight line, and measure its slope in units where each power of 10 on the plot counts as 1 unit. The numerical value of your slope is your measurement of $\alpha$.

You can get WPTools to do the equivalent of the above procedure by entering the log of your data for $R$ and $Q$ in your Excel sheet. As hinted in Appendix A, if a value of $R$ is in cell A2, you can put its log in cell C2 by clicking on that cell and typing $=\log(A2)$ in the formula bar of the sheet. After typing Enter, the value should appear. Then, drag downwards on the little box in the lower right corner of the cell to take the log of your other values of $R$. After creating a column the values of log($Q$) as well, use WPTools to make a scatter plot of log($Q$) vs. log($R$), and do a linear fit. Then parameter $a1$ is the value of $\alpha$, and SE(a1) is an estimate of the uncertainty in your measurement of $\alpha$.

Next, find the viscosity $\eta$. For this part of the analysis, assume that the exponent $\alpha = 4$. Rework Poiseuille's equation to extract the value of the coefficient of viscosity, and use your three measurements of $Q$ to calculate three values of $\eta$. Are the values close to each other? As mentioned in Appendix B, a simplified error analysis is to report the average of the 3 values of $\eta$ as your best estimate, with an uncertainty of $|\eta_{\text{max}} - \eta_{\text{min}}| / 2$.
II. Terminal Velocity

An object falling through a viscous fluid feels three forces. Gravity pulls the object downward:

\[ F_{\text{grav}} = \rho V g \]

where \( \rho \) and \( V \) are the density and volume of the object, respectively, and \( g \) is gravitational acceleration. The buoyant force pushes the object upward:

\[ F_{\text{buoy}} = \rho_f V g, \]

where \( \rho_f \) is the density of the fluid. Finally, there is a drag force opposing the motion of the object. Stokes' law gives the drag force on a spherical object of radius \( R \) moving with velocity \( v \) in a viscous medium:

\[ F_{\text{drag}} = 6\pi \eta R v \left( \frac{A}{R} \right), \]

where \( R \) is the radius of the sphere. When these three forces balance, no net force acts on the sphere, so it falls with constant velocity, called “terminal velocity”. Combine the expression of the three forces acting on the spherical object to derive the expression of the “terminal velocity”.

Specific Instructions and Analysis

Test the equation you just derived by measuring the terminal velocity of small lead spheres (of density \( \rho = 11.7 \text{ g cm}^{-3} \)) that fall through the oil you analyzed in the first part of the Lab.

Measure the diameter of one of the spheres, taking an average of several measurements if it isn't really spherical. Measure the velocity of the sphere falling through the oil using a stopwatch. Repeat the experiment for at least three different spheres. Are the measured values close to the values predicted by your equation?

Assuming Stokes’ law to be correct, use your measurements of the terminal velocity to deduce another experimental value (and uncertainty) of the viscosity \( \eta \) of the fluid. Compare with your value from the first part of the Lab.
III. Buoyant Force

The density of gas in a helium balloon is less than the density of the surrounding air, so the balloon feels a net upward force. The buoyant force ($\rho_{\text{air}} = 1.29 \text{ kg m}^{-3}$ at 1 atm pressure) can be balanced by hanging a mass below the balloon as in figure 2.

The total weight is:

$$W_{\text{total}} = (m_1 + m_{\text{string}} + m_{\text{balloon}} + m_{\text{He}})g$$

where $m_1$ is the mass hanging below the balloon, $m_{\text{string}}$ is the mass of the string, $m_{\text{balloon}}$ is the mass of the (empty) balloon, and $m_{\text{He}}$ is the mass of the helium within the balloon.

The masses of the balloon, string, and hanging weight can be measured on scales, but for the mass of the helium you have to rely on measurements of volume and pressure. Given that the atomic mass of helium is 4, if there are $n$ moles of helium in the balloon, the mass is $m_{\text{He}} = 4.00 \text{ g} \cdot n$.

The ideal gas law relates $n$ to the pressure, volume, and temperature of the balloon ($P$, $V$, and $T$) and the universal gas constant: $P V = n R T$. Solving for $n$ and substituting $R = 8.3145 \text{ J mol}^{-1} \text{ K}^{-1}$ and $T = 293\text{K}$ (approximate room temperature) allows you to calculate the mass.
Specific Instructions and Analysis

Measure the mass of the empty balloon. Fill it with helium, and after stopping the flow of helium, measure the pressure within the balloon before tying off the end of the balloon. You may need the following conversion factors: 1 psi = 6985 Pa, 1 atm = 1.013 x 10⁵ Pa. Also, remember to add the atmospheric pressure to the "gauge pressure" reading on the pressure meter.

![Figure 3: Measuring the dimensions of a balloon.](image)

Next measure the volume of the balloon. One way of doing this is to put it on a table, hold a meter stick vertically next to it, and use a wooden board to help measure its size on the meter stick. (See figure 3.) You can estimate the size of the balloon from the dimensions \(d_1\) and \(d_2\).

Cut a piece of string a couple of feet long, measure its mass and tie it to the bottom of the balloon. Finally, tie a 5-g hanger to the string and keep adding weights to the hanger until the balloon is in equilibrium. To fine-tune the hanging weight, you may want to use small paper clips (about 0.3 g each) or pieces of tape. After you have achieved equilibrium, detach the hanger and its weights and measure their mass on a scale.

Now you have all the pieces of data you need to test the buoyancy formula. Calculate the buoyant force and the weight. Are they close to each other?
LAB #3: COLLISIONS IN TWO DIMENSIONS

BEFORE YOU COME TO LAB

- Read the writeup for this lab, and plan how you will approach it intellectually.
- Consider the optional PreLab problem set attached.

A. Introduction

The two parts to this lab both involve the motion of “hockey pucks” on an essentially frictionless air table. The air flows out through a set of small holes in the surface of the air table, which cancels out the normal force of gravity, and the pucks move freely in the plane. You will use the video camera and VideoPoint software to analyze their motion.

In the first experiment, two pucks are launched with some initial speeds and directions. They then collide, and head off with different speeds and directions of motion. Since there is no external horizontal force acting on the pucks, the sum of their vector momenta should be conserved (i.e., should be the same before and after the collision). Your experiment is to confirm this fundamental fact, by direct measurement of the components of the vector velocity (and vector momenta). You will also check whether kinetic energy was conserved in the collision. Of course, your measurements can only confirm anything to within some experimental uncertainty, which will be part of your analysis.

In the second experiment, you will study a totally inelastic collision, and check whether energy and momentum are conserved in this case.
B. General Instructions

Start by making a video of a simple collision between two pucks. Be sure to include a meter stick in the camera's field of view, for use in scaling your movie. Weigh each puck to determine its mass so that you can later convert its velocity to momentum.

Check that pucks do not glide in any particular direction when placed at "rest" on the air table. If they do, adjust the three leveling feet on which it stands. Don't spend too much time on this – you'll never make it perfectly level.

Immediately after opening VideoPoint, you should tell the system that you want to measure the positions of 2 objects in each frame, rather than 1. Then you will want to pick off the coordinates of the 2 pucks. VideoPoint makes it easy to pick off the coordinates of Puck 1 in Frame 1, then of Puck 2 in the same frame, and then Puck 1 and Puck 2 in Frame 2, etc.

To do this:

- Check that, in the Options menu item on the movie screen, both the AutoFrame Advance and Auto Point Advance options have check marks beside them.
- Pick off the location of the first puck on the first frame, then click on Edit / Leave/Hide Trails.
- Move to the second puck, and pick off its location. Then click on Edit / Leave/Hide Trails again.
- The movie should automatically advance to the second frame, while showing the “trails” from Frame 1. If you continue to click first on Puck 1, and then on Puck 2, in each frame, the data sequence should continue from frame to frame without help from you. (If, at any time, you want to change whether a puck's trail is displayed or not, just use the Leave/Hide Trails button again, for whichever puck you want to affect.
- If your pickoff sequence gets confused, and you need to remove a point or to start over, you can use the Edit/Clear Selection on Frame and Edit/Clear Selection on All Frames commands to remove erroneous points. (Selecting a point may require carefully clicking on its position in the Movie screen. A selected point will appear with a double circle.)

After you have entered all your coordinates, transfer them to an Excel spreadsheet for your analysis. Make the usual graphs of $x$- and $y$-position, $x$- and $y$-velocity, etc. Make separate graphs for each set of points for which you wish to determine a puck’s $x$ or $y$-velocity. Use WPTools and a Linear Fit (or better, Polynomial Fit of order 2) to determine the velocity and the estimate of the uncertainty.
After converting velocities to momenta, you can see if (to within your measurement accuracy) momentum is conserved. Show your logic, and justify your conclusions, in your notebook.

C. Nearly Elastic Collisions

Use pucks **without** Velcro bands in part C. Make and analyze a movie of an `elastic` collisions between the two pucks. Report results as to conservation of momentum of the system of two pucks separately for its \(x\)- and \(y\)- components.

Do you find that the sum of the kinetic energies of the two pucks is the same after the collision as before (i.e., that kinetic energy is conserved in the collision)? If not, where did the “missing” energy go?

*A single movie suffices for the study of both energy and momentum. It’s better if the initial velocities of the pucks are not parallel to an edge of the air table.*

D. Totally Inelastic Collisions

Use pucks **with** Velcro bands. *If there are white Velcro bands at your Lab table, add these to plain pucks. If there are pucks with black Velcro bands, do not try to remove the Velcro.*

Make and analyze a movie of the inelastic collision of these pucks. Was momentum conserved here, according to your data? What fraction of the initial kinetic energy remained after the collision?

Appendix: Error Propagation

The total \(x\)-momentum in a collision of two pucks of masses \(m_1\) and \(m_2\) is \(P_x = m_1v_{1,x} + m_2v_{2,x}\), so the uncertainty in \(P_x\) is given by

\[
\sigma_{P_x} = \sqrt{v_{1,x}^2\sigma_{m_1}^2 + m_1^2\sigma_{v_{1,x}}^2 + v_{2,x}^2\sigma_{m_2}^2 + m_2^2\sigma_{v_{2,x}}^2}.
\]

Likewise, the uncertainty on their kinetic energy, \(KE = \frac{m_1(v_{1,x}^2 + v_{1,y}^2)}{2} + \frac{m_2(v_{2,x}^2 + v_{2,y}^2)}{2}\), is given by

\[
\sigma_{KE} = \sqrt{\frac{v_{1,x}^2 + v_{1,y}^2}{4}\sigma_{m_1}^2 + m_1^2\left(v_{1,x}^2\sigma_{v_{1,x}}^2 + v_{1,y}^2\sigma_{v_{1,y}}^2\right) + \left(v_{2,x}^2 + v_{2,y}^2\right)^2\sigma_{m_2}^2 + m_2^2\left(v_{2,x}^2\sigma_{v_{2,x}}^2 + v_{2,y}^2\sigma_{v_{2,y}}^2\right)}.
\]
PRELAB Problems for Lab #3: Collisions in Two Dimensions

1. Referring to the figure on the following page, make sketch plots of the behavior of $v_x$ and $v_y$ for each of the two pucks as a function of time. Although you don't know the scales of either position or time, be careful to get the signs correct, and to show at least roughly correct relative magnitudes.

2. Avik and Venus are calculating the momentum and kinetic energy of a puck on their air table. The puck is moving parallel to the x axis with a speed of $12.0 \pm 0.2$ m/sec, and its mass is $30.00 \pm 0.01$ grams.
   a) What is the x-component of the momentum of the puck, and what is its uncertainty? How much would the uncertainty change if the mass were precisely known (i.e., if the uncertainty in the mass was negligibly small)?
   b) What is the kinetic energy of the puck, and what is its uncertainty? How does the fractional uncertainty in kinetic energy compare to the fractional uncertainty in momentum?

3. Deduce the formulae in the Appendix of this Lab, possibly referring to sec. B.8 of the Appendices to the Lab Manual.
Figure for PreLab #1. This is the final frame of a video of two colliding pucks. The y-axis points toward the top of the page, and the x-axis points to the right.
LAB #4: ROLLING FRICTION

BEFORE YOU COME TO LAB:

- Read the writeup for this lab, which concerns rolling friction. This topic is not discussed in the Precepts, so the physics discussion in this writeup is more extensive than in the previous ones.

A. Introduction

In this lab, you will use your cameras and VideoPoint/Excel software to study rolling motion on an inclined plane.

The wheel is a great invention in that it avoids loss of mechanical energy due to sliding friction. When a wheel rolls without slipping, static friction is required to avoid sliding/slipping at the point of contact of the wheel with the surface on which it rolls. Static friction $F_s$ does no work, because the velocity $v$ of the point of contact (where the force of static friction applies) is zero, and hence $W_s = F_s \cdot v = 0$.

A rolling wheel is subject to energy loss associated with friction at the axle, deformation of the wheel (or the ball bearings in the wheel) and/or the surface on which the wheel rolls. In this Lab, rolling friction will be modeled as acting on being proportional to the normal force $N$ on the wheel, directed opposite to the velocity of the center of the wheel,

$$F_r = -\mu_r N \hat{v},$$

where $\mu_r$ is the coefficient of rolling friction, and $\hat{v} = v / v$ is the unit velocity vector. For other models of rolling friction, see [http://en.wikipedia.org/wiki/Rolling_resistance](http://en.wikipedia.org/wiki/Rolling_resistance)

In this Lab, you will study the motion of a 3-wheeled cart as it rolls up and back down a plane inclined at angle $\theta$ to the horizontal, and you will determine the coefficient $\mu_r$ of rolling friction by analysis of the acceleration of the cart, followed by analysis of its kinetic energy.

The rolling friction acts at some radius $r$ (or several different radii) from the center of the wheel. In this Lab you will only determine the quantity $\bar{\mu}_r \equiv \mu_r (1 - r / R)$ where $R$ is the radius of the wheel. *If the rolling friction acted precisely at the outer radius of the wheel, then like static friction it would do no work. Pump up your bicycle tires for a lower-friction (but bumpier) ride!*
**Acceleration**

The acceleration \( a \) of the cart when it rolls up the inclined plane is different from the acceleration \( a' \) when it rolls down, although both vectors \( a \) and \( a' \) point down the slope. Each wheel of radius \( R \) has angular acceleration \( \alpha = a/R \) when rolling uphill, and \( \alpha' = a'/R \) when rolling downhill. In both cases the angular acceleration is clockwise in the figure above. This angular acceleration is due to a clockwise torque, which implies that the force of static friction (at the point of contact of the wheel with the inclined plane) points up the slope.

Considering the system as a whole, it has no acceleration normal to the slope, and acceleration of magnitude \( a \) or \( a' \) down the slope. The normal force on each wheel has magnitude \( N \) (assumed equal for the three wheels) related by

\[
N = \frac{M_T}{3} g \cos \theta, \tag{2}
\]

where \( M \) is the mass of the body of the cart and \( m \) is the mass of each of its wheels, and

\[
M_T = M + 3m, \tag{3}
\]

According to eq. (1) the force of rolling friction on each wheel has magnitude

\[
F_r = \mu_r N = \mu_r \frac{M_T}{3} g \cos \theta. \tag{4}
\]

The acceleration \( a \) of the cart when it moves up the slope is related by

\[
M_T a = M_T g \sin \theta + 3F_r - 3F_s = M_T g (\sin \theta + \mu_r \cos \theta) - 3F_s, \tag{5}
\]

When the cart moves down the slope with acceleration \( a' \), the direction of rolling friction is reversed but its magnitude is the same, while the direction of static friction is the same but its magnitude \( F_s' \) is different. Thus,

\[
M_T a' = M_T g (\sin \theta - \mu_r \cos \theta) - 3F_s'. \tag{6}
\]

If the forces \( F_r \) and \( F_s' \) of static friction were equal the coefficient \( \mu_r \) of rolling friction would be simply related to the difference \( a - a' \). But, they are not equal, and must be determined via a torque analysis of a wheel. The moment of inertia of each wheel is given by

\[
I = kmR^2, \tag{7}
\]
where \( k = 1 \) for a hoop, \( k = \frac{1}{2} \) for a solid disk, and \( k \approx 0.8 \) for the wheels used in this Lab.

The torque analysis (about the center of a wheel) when the cart rolls uphill is

\[
\tau = RF_\alpha - rF_r = I\alpha = kmR^2 \frac{a}{R}, \quad \text{so that} \quad F_\alpha = kma + \frac{r}{R} F_r = kma + \mu_r \frac{M_T}{3} g \frac{r}{R} \cos \theta, \quad (8)
\]

since gravity and the normal force \( N \) (and the internal force of the cart on the wheel) exert no torque about the center of the wheel. When the cart rolls downhill, the torque analysis is

\[
\tau' = RF_\alpha' + rF_r' = I\alpha' = kmR^2 \frac{a'}{R'}, \quad \text{so that} \quad F_\alpha' = kma' - \frac{r}{R} F_r = kma' - \mu_r \frac{M_T}{3} g \frac{r}{R} \cos \theta. \quad (9)
\]

Combining eqs. (5) and (8), and also eqs. (6) and (9), we obtain two equations for the two unknowns \( \mu_r \) and \( k \),

\[
\mu_r \left(1 - \frac{r}{R}\right) M_T g \cos \theta - 3kma = M_T(a - g \sin \theta), \quad (10)
\]

\[
\mu_r \left(1 - \frac{r}{R}\right) M_T g \cos \theta + 3kma' = -M_T(a' - g \sin \theta). \quad (11)
\]

**Note that if \( r = R \) then there is no effect of friction.** The solutions to eqs. (10)-(11) are

\[
\tilde{\mu}_r = \mu_r \left(1 - \frac{r}{R}\right) = \frac{a - a'}{a + a'} \tan \theta, \quad \text{and} \quad k = \frac{M_T}{3m} \left(\frac{2g \sin \theta}{a + a'} - 1\right). \quad (12)
\]

Under the possibly naïve assumption that the relative uncertainties in \( m, M, r, R \) and \( \theta \) are negligible, the uncertainties on the measurements of \( \tilde{\mu}_r \) and \( k \) are

\[
\sigma_{\tilde{\mu}_r} = \frac{2 \tan \theta}{(a + a')^2} \sqrt{\sigma^2_a + \sigma^2_{\theta}}, \quad \text{and} \quad \sigma_k = \frac{M_T}{3m} \frac{2g \sin \theta}{(a + a')^2} \sqrt{\sigma^2_a + \sigma^2_{\theta}}. \quad (13)
\]

**Energy**

Another approach is to consider the work-energy relation of uphill and downhill motion of the cart while it travels distance \( s \) along the slope. In this case the change in potential energy is

\[
\Delta PE = M_T g s \sin \theta. \quad (14)
\]

When the cart has linear speed \( v \) the angular velocity of the wheel is \( \omega = v / R \), so the total kinetic energy of linear plus rotational motion is

\[
KE = \frac{M_T v^2}{2} + \frac{3I \omega^2}{2} = \frac{(M_T + 3km)v^2}{2}. \quad (15)
\]

No work is done by static friction (assuming that the wheel rolls without slipping), but rolling friction does (negative) work on the cart. However, the work done by rolling
friction is not simply $-F_r s$, because the torque due to rolling friction acts to increase the angular velocity and does positive work $\tau \phi = rF_r s / R$. That is, the total work done by rolling friction of the three wheels has magnitude

$$W_r = 3F_r s \left(1 - \frac{r}{R}\right) = \mu_r M_r g s \cos \theta \left(1 - \frac{r}{R}\right). \quad (16)$$

If the cart is launched uphill with initial speed $v_0$ and comes to rest after traveling distance $s$ along the slope, the work-energy relation obtained from eqs. (14)-(16) is

$$W_r = KE_0 - \Delta PE, \quad \text{or} \quad \mu_r \left(1 - \frac{r}{R}\right) M_r g s \cos \theta = \frac{3kmv_0^2}{2} = M_r \left(\frac{v_0^2}{2} - gs \sin \theta\right). \quad (17)$$

Similarly, if the cart starts from rest and rolls distance $s'$ down the slope to attain final speed $v_f$, then $\Delta PE' = KE_f + W_r'$, and

$$\mu_r \left(1 - \frac{r}{R}\right) M_r g s' \cos \theta = \frac{3kmv_f^2}{2} = M_r \left(\frac{v_f^2}{2} - gs' \sin \theta\right). \quad (18)$$

From eqs. (17)-(18),

$$\tilde{\mu}_r = \mu_r \left(1 - \frac{r}{R}\right) = \frac{1}{\cos \theta} \frac{s'v_0^2 - sv_f^2}{s'v_0^2 + sv_f^2}, \quad \text{and} \quad k = \frac{M_r}{3m} \left(\frac{4gs' \sin \theta}{s'v_0^2 + sv_f^2} - 1\right). \quad (19)$$

Assuming that the uncertainties on $m, M, r, R$ and $\theta$ are negligible, the uncertainties on $\mu_r$ and $k$ are

$$\sigma_{\tilde{\mu}_r} = \frac{1}{\cos \theta} \frac{v_0 v_f}{(s'v_0^2 + sv_f^2)^2} \sqrt{v_0^2 v_f^2 \left(s'^2 \sigma_v^2 + s^2 \sigma_f^2\right) + 4s^2 s'^2 \left(v_f^2 \sigma_v^2 + v_0^2 \sigma_f^2\right)}, \quad (20)$$

and

$$\sigma_k = \frac{4M_r g s \sin \theta}{3m \left(s'v_0^2 + sv_f^2\right)^2} \sqrt{s'^4 v_0^4 \sigma_v^2 + s^4 v_f^4 \sigma_f^2 + 4s^2 s'^2 \left(s'^2 v_0^2 \sigma_v^2 + s^2 v_f^2 \sigma_f^2\right)}. \quad (21)$$

**B. Things to Do**

It is important that the optical axis of the camera is perpendicular to the vertical plane of the motion of the rolling cart. That vertical plane should be parallel to the black backdrop or your setup. The person who launches the cart should verify that it moves parallel to the backdrop. If not, try again.

You will find a ball hanging from a string at your station, which you can use to verify that the rotation of the camera about its optical axis is proper. It is more difficult to verify that the optical axis of the camera is perpendicular to the backdrop, but if it isn’t, your later fits will have significantly nonzero cubic and quartic terms.
Weigh your cart using a balance on the center table. **Do not overload the digital balances.** There is a sample wheel on the center table, but its mass is not necessarily the same at that of the wheels on your cart. A survey of 5 wheels yielded $m = 85.1 \pm 0.7 \text{ g}$.

You can adjust the height of your ramp so that it takes about 1 sec for the cart to roll from the top to the bottom of the ramp. Use a meter stick to measure an appropriate height and horizontal distance to determine the angle $\theta$. Leave the meter stick in view, under the ramp along the center of the cart's path, so that you can determine the scale factor of your movie.

You only need one good movie for all the analysis in this lab.

However, you can take a short movie without the cart and digitize the ramp, transfer the data to Excel and make a linear fit of $y$ vs. $x$ to determine $\tan \theta$. **Compare with your result obtained using the meter stick. You could also use this movie to determine the scale factor of your movie.**

**Main Data Analysis**

In your main movie, launch the cart up the ramp, such that it comes to rest near the top of the ramp and then rolls back down the ramp. After using VideoPoint to digitize the trajectory of some point on your rolling cart, transfer the data $(x, y, t)$ to Excel. Identify which points are on the upward part of the trajectory, and which are on the downwards. In general, you will not have digitized a point that corresponds to the cart being exactly at rest.

For the upward moving points, make plots of $x$ vs. $t$ and $y$ vs. $t$, and then make quartic polynomial fits to these. If the cubic or quartic terms are large compared to their uncertainties (as reported by WPTools), consider realigning your camera and/or launching the cart on a path more nearly parallel to the backdrop.

If you haven’t already done so, multiply your $x$- and $y$-data by your scale factor to convert them to cm (or m).

To find the factor $k$ of the wheels and the coefficient $\frac{\mu_c}{\mu_f}$ of rolling friction according to the formulae of part A, you need the acceleration $a$, the initial velocity $v_0$, and the distance the cart travelled up the ramp before stopping. And from fits to your data from the downward motion of the cart, you need to find $a'$, $v_f$ and $s'$. To speed up the analysis of the motion along the inclined plane, divide your digitized data $\{x_i, y_i\}$ into two sets, one for motion up the plane, say $i = 1$ to $m$, and the other from motion down the plane, say $i = m + 1$ to $n$. For the first set, use Excel to calculate $s_i = \sqrt{(x_i - x_{i-1})^2 + (y_i - y_{i-1})^2}$, and for the second set, $s'_i = \sqrt{(x_i - x_{n+1})^2 + (y_i - y_{n+1})^2}$. 

33
Possible trick: subtract the final time $t_f$ from the times $t_i$ during the downward motion, to redefine $t'$ to be zero at your last point. Then, the linear coefficient in your fit of $s'\text{ vs. } t'$ will be $v_{f,x}$. Of course, the acceleration $a'$ is twice quadratic coefficient. The distance the cart travelled down the slope is then $s' = \sqrt{v_{f,y}^2 / 2a'}$, and the uncertainty on this measurement is given by $\sigma^2_s = \frac{\sigma^2_{v_{f,y}}}{2a'} + \frac{v_{f,y}^2 \sigma^2_{a'}}{8a'^3}$.

Do your measurements of the accelerations $a$ and $a'$ differ by more than their uncertainties? If so, you have evidence for nonzero rolling friction. Equation (12) then gives a particular interpretation of this, which permits you to assign a value (and uncertainty!) to the coefficient $\bar{\mu}$ of rolling friction.

In the energy analysis, you could also estimate the $x$- and $y$-coordinates of the point where the cart stopped by an interpolation between your upward and downward data points, and make a quick error estimate for $s$ and $s'$ as determined by this procedure. Which method is “better,” in the sense of giving a smaller uncertainty?

Did you get “better” results for $\bar{\mu}$ and $k$ via your analysis of the acceleration or of the energy?

C. Option: Rolling Other Stuff on the Ramp

What happens when you roll a ball, a hollow "pipe," or a solid circular cylinder down the ramp? If you roll two of them down side by side, which one gets to the bottom first? Is mechanical energy conserved here? If not, where is it going?

If time permits, make movies of a couple of these objects rolling down the ramp, and look at the acceleration and energy graphs. Compare the acceleration of these objects to that of your cart. *What's going on here? -- There's more to consider than meets the eye!*
LAB #5: ROTATIONAL MOTION

BEFORE YOU COME TO LAB:

- Consider the “optional” PreLab problem set attached. Note that you need the answer to problem 2 to complete the Lab.

This week you will do two experiments involving rolling objects for which friction can be largely ignored. The setup for each experiment is different; pick whichever one you want to do first, and go to one of the setups for that experiment at the start of the lab. (Be flexible.) The two projects in this week’s Lab might be relevant to engineers designing theme park rides, courses for downhill ski races, etc. They will remind you of roller coaster loops and of racers taking to the air after speeding across a bump.

A: Rolling Off a Log

You may have already worked out the problem of an object sliding off a frictionless circular track. The object leaves the track at an angle \( \theta = \cos^{-1}(2/3) = 48.2^\circ \). In this Lab you minimize friction by letting an object roll down the circular track. In the Prelab problems you are encouraged to show that the theoretical expression for the angle at which a rolling object of mass \( m \), radius \( r \), and moment of inertia \( I = kmr^2 \) about its center leaves the track is \( \theta = \cos^{-1}\left(\frac{2}{3+k}\right) \). Hence, \( k = \frac{2}{\cos \theta} - 3 \), and

\[
\sigma_k = \frac{2 \sin \theta}{\cos^2 \theta} \sigma_\theta.
\]

The idea of this experiment is to work out a technique whereby you can measure as accurately as possible the angle where the rolling object just leaves the track, and thereby determine the \( k \) factor (and uncertainty on this) for a solid cylinder, a hollow cylinder, and a sphere.

You may find that using chalk dust, or wetting the object before you start it rolling, causes it to leave a track which answers the question. Alternatively, you can make a movie and use VideoPoint to determine the takeoff angle.

If you choose to use VideoPoint, it will be convenient to convert to polar coordinates from the usual Cartesian \((x,y)\) coordinate system. Then, after moving the origin of the
coordinate system to the center of the track, you can plot \textit{radius} versus time to see if you can determine the takeoff angle.

**Using VideoPoint with polar coordinates**

To change to polar coordinates, double-click on the origin and make the change in the first screen shown below. The origin can be moved to the center of the track simply by clicking-and-dragging on it. Then you can choose to plot radius or angle when you make your graphs. (See the second screen shown.

However you choose to do your analysis, once you have your technique down for one object, try it on the others, and think about any differences you find.

You can (with practice) balance a ball by spinning it on your fingertip. Can you balance a ball on a log by spinning it?
**B: Loop-the-Loop**

You can roll a ball down a ramp, and it will pick up enough speed to “loop the loop.” Determine experimentally the minimum height \( h \) such that the ball loops the loop without leaving the track. From this measurement (and its uncertainty), determine the \( k \) factor of the ball (and the uncertainty on \( k \)).

![Diagram of Loop-the-Loop](image)

**C. Angular Momentum Toys**

Take some time during the Lab to play with the angular momentum toys:

- Rotating stool + hand weights or bicycle wheel
- Bicycle wheel by itself: hold it with two hands, or via the rope on one handle.

Spin the wheel up by hand (your Lab partner can help with this).

For the rotating stool + hand weights, think about conservation of angular momentum:

\[
L = Iω \approx 2Wrω = I'ω' \approx 2Wr'ω'.
\]

For the spinning bicycle wheel think about the vector equation for changes in angular momentum due to torques:

\[
\frac{dL}{dt} \approx I \frac{dω}{dt} = r × F.
\]

When holding the bicycle wheel by the rope such that its angular velocity vector \( ω \) is horizontal, it precesses about the vertical with angular velocity \( Ω \) according to

\[
I \frac{dω}{dt} = Ω × Iω = r × mg.
\]

Since vectors \( ω \) and \( Ω \) are perpendicular, and vectors \( r \) and \( g \) are perpendicular, the equation of motion simplifies to \( Ω = \frac{mgr}{Iω} \). Can you verify that the faster you spin the wheel, the slower it precesses? Can you keep track of the vector cross products to predict whether the precession is clockwise or counterclockwise, as viewed from above?
PRELAB Problems for Lab #5: Rotational Motion

1. An object of radius $r$, mass $m$, and moment of inertia $I = km^2$ about its axis starts from rest at the top of a large cylinder of radius $R$ and rolls down. At what angle $\theta$ from the vertical does the object leave the surface of the large cylinder? (Hint: This problem is of the example of a frictionless mass that slide down (and falls off a “log”), which you solved using conservation of energy and $F = m\frac{v^2}{R}$. In this problem, you have an extra energy term due to the ball’s rotation, which you can relate to its translation using $v = \omega r$.)

2. A ball has radius $r$, mass $m$, and moment of inertia $I = km^2$ about its center. The ball starts at rest, rolls without slipping down a ramp, and does a loop-the-loop of radius $R$. (See the figure for Experiment B.) What is the height $h$ above the top of the loop that the ball must be started at to make it around the loop-the-loop without leaving the track? (Hint: This problem is similar to the loop-the-loop for a frictionless mass, which you also solved using conservation of energy. In this Prelab problem, you have an extra energy term associated with the ball’s rotation, which you can relate to the ball’s translation using $v = \omega r$.) Give an expression for the $k$ factor in terms of $m$, $h$, $r$ and $R$, and for the uncertainty $\sigma_k$ due to the uncertainty $\sigma_h$ in a measurement of height $h$. 
LAB #6: A PRECISION MEASUREMENT OF $g$

Do not disassemble your pendulum to measure the mass of the bob or the wire. Instead, there are additional bobs and wires on the table in the center of the lab which you can weigh and measure.

Overview

So far, the experiments in Physics 103/105 Lab have addressed physical principles to an accuracy of 5 to 10%. This is fine for getting a feel for how things work, but another objective of experimental physics is to measure precise values for constants of nature. To make a precise measurement, one designs an experiment to minimize systematic effects or to make them easy to calculate. In this lab you will measure $g$, the acceleration due to gravity at the Earth’s surface, by timing a pendulum. With care in your technique and attention to systematic effects you can achieve an accuracy of much better than 1%.

Uncertainty analysis is an essential part of this lab. During this lab, you will carefully apply the methodology of combining random errors from repeated measurements using the concepts of standard deviation and standard error. We have provided a spreadsheet to do most of the calculations for you. But you are responsible for thinking about the results. You may want to review Appendices B and C on Estimation of Errors in the Labs section of the Blackboard.

Theory of a Real (Physical) Pendulum

A high-precision experiment requires unusual effort both in technique and in the underlying theory. In this section we extend the theory of a simple pendulum to the level needed for a precise measurement of $g$.

Your textbook shows that for a simple pendulum of length $L_0$, the period $T_0$ is given by

$$T_0 = 2\pi \sqrt{\frac{L_0}{g}}.$$  \hspace{1cm} (1)

Inverting this equation, we can calculate the value of $g$ by timing the period of such a pendulum:

$$g = 4\pi^2 \frac{L_0}{T_0^2}, \quad \Rightarrow \quad \frac{\sigma_g}{g} \approx \frac{\sigma_{T_0}}{L_0}, \quad \text{if} \quad \frac{\sigma_{T_0}}{T_0} \text{ is negligible.}$$  \hspace{1cm} (2)
However, at the level of accuracy we are aiming for \((\sigma_g / g = 0.001)\), we may not assume that our pendulum is a simple pendulum. There are two important effects that make the simple pendulum assumption break down. Our physical pendulum is 1) not a point mass suspended by a massless string, and 2) not a true harmonic oscillator (because the restoring term in the equation is not exactly proportional to the displacement). If we were to neglect either of these two effects, we would find that our measurement of \(g\) was systematically off.

Consider the consequences of the first effect. For a physical pendulum of total mass \(M_T\), moment of inertia \(I\) about the pivot point, and distance \(D_{cm}\) between the pivot point and the center of mass, the torque equation about the pivot point is

\[
\tau = -D_{cm}M_T g \sin \theta \approx -D_{cm}M_T g \theta = I\alpha = I \frac{d^2 \theta}{dt^2},
\]

(3)

so \(\theta \approx \theta_0 \cos \omega t\) where the angular frequency is given by \(\omega = \sqrt{\frac{D_{cm}M_T g}{I}}\), and the period \(T_0\) for small oscillations is given by

\[
T_0 = \frac{2\pi}{\omega} = 2\pi \sqrt{\frac{I}{M_T D_{cm} g}}, \quad \text{and hence} \quad g = \frac{4\pi^2}{T_0^2} \frac{I}{M_T D_{cm}}.
\]

(4)

You may approximate your pendulum as a cylindrical bob of mass \(M\), height \(h\) and radius \(r\), suspended on a long thin wire of mass \(m\). Let the distance from the pivot to the top of the cylindrical bob be \(L\). (See the sketch above.) The moment of inertia of a thin disc
about a diameter is \( dl = dm \frac{r^2}{4} \) (which follows from the momentum of inertia \( dm \frac{r^2}{2} \) about its axis using the so-called perpendicular axis theorem). Then using the parallel axis theorem, the moment of inertia of the bob (= a stack of thin discs) about the pivot point is given by

\[
I_{bob} = \int \left[ \frac{dm}{4} r^2 + dm(L + h - x)^2 \right] = \int_0^h M dx \left[ (L + h - x)^2 + \frac{r^2}{4} \right] = M \left( L^2 + Lh + \frac{h^2}{3} + \frac{r^2}{4} \right).
\]

so that \( I = I_{bob} + I_{\text{string}} = M \left( L^2 + Lh + \frac{h^2}{3} + \frac{r^2}{4} \right) + m \frac{L^2}{3} = ML^2 \left( 1 + \frac{h}{L} + \frac{h^2}{3L^2} + \frac{m}{3M} \right). \tag{5} \]

The distance \( D_{cm} \) from the pivot to the center of mass of the bob is given by

\[
M_T D_{cm} = M \left( L + \frac{h}{2} \right) + \frac{ML}{2} = ML \left( 1 + \frac{h}{2L} + \frac{m}{2M} \right). \tag{6} \]

Substituting equations (5) and (6) into (4), we obtain

\[
g = \frac{4\pi^2L}{T^2} \left( 1 + \frac{h}{L} + \frac{h^2}{3L^2} + \frac{r^2}{4L^2} + \frac{m}{3M} \right) \left( 1 + \frac{h}{2L} + \frac{m}{2M} \right). \tag{7} \]

Because the torque equation (3) is not exactly the form of the equation for a simple harmonic oscillator, the period \( T \) is depends on the maximum angle \( \theta_0 \) of the motion of the pendulum. A more advanced analysis shows that

\[
T = T_0 \left( 1 + \frac{1}{4} \sin^2 \frac{\theta_0}{2} + \frac{9}{64} \sin^4 \frac{\theta_0}{2} + \ldots \right), \tag{8} \]

where \( T_0 \) is period assuming the system to be a simple harmonic oscillation, as in eq. (6). Remember, \( T \) is the period that you measure, and \( T_0 \) from equation (6) is the period that you would have measured for your physical pendulum if \( \theta_0 \) were very small.

The following table gives you an idea of how big the difference between \( T \) and \( T_0 \) can be, according to eq. (8).

<table>
<thead>
<tr>
<th>( \theta_0 )</th>
<th>( T / T_0 )</th>
<th>( \theta_0 )</th>
<th>( T / T_0 )</th>
</tr>
</thead>
<tbody>
<tr>
<td>0°</td>
<td>1.00000</td>
<td>10°</td>
<td>1.00191</td>
</tr>
<tr>
<td>5°</td>
<td>1.00048</td>
<td>11°</td>
<td>1.00231</td>
</tr>
<tr>
<td>6°</td>
<td>1.00069</td>
<td>12°</td>
<td>1.00275</td>
</tr>
<tr>
<td>7°</td>
<td>1.00093</td>
<td>13°</td>
<td>1.00323</td>
</tr>
<tr>
<td>8°</td>
<td>1.00122</td>
<td>14°</td>
<td>1.00374</td>
</tr>
<tr>
<td>9°</td>
<td>1.00154</td>
<td>15°</td>
<td>1.00430</td>
</tr>
</tbody>
</table>
I. Measuring the Period

Measure the period of your pendulum using the light-activated electronic timer on your table. On period is a full cycle (= two half cycles), such that the bob passes through the photogate in the same direction at the beginning and end of a period.

Set the mode switch to $P$ so that the pendulum turns the timer on and off with successive passes. To time multiple periods, hold down the telegraph key on your table to keep the timer from being switched on and off with every pass. Set the switch on the back of the timer to manual reset to keep the display from resetting to zero immediately after every measurement. The timer can measure 1, 10, 100, or 1000 second intervals. Use the 100 second interval.

Measure the period for $\theta_0 = 10^\circ$, timing the pendulum for a total of ten periods in a single measurement (rather than making 10 measurements of a single period), and dividing that result by 10. Estimate the random error by repeating the measurement about five times. Feel free to use Excel to help you with averaging or other calculations. After using your computer to calculate $g$ in part III below, go back and repeat the measurement for $\theta_0 = 5^\circ$ and $15^\circ$.

Tips on Technique:

- Be certain to time 10 complete periods (= an even number of half periods); otherwise the placement of the light beam affects the measurement. If your value of $g$ is off by more than 2%, you likely did not measure 10 complete measurements.
- Center the light beam to make the durations of half cycles the same on both sides. There would be a small systematic shift in the measurement of the period due to the damping of the amplitude, if the light beam is not centered.
- Do not use amplitudes below $5^\circ$. Even if the light beam is centered, the finite size of the light beam causes a systematic error that is significant for small amplitudes.
- Check that when you release the bob it swings to a maximum angle close to the desired release angle. If your release is “hesitant”, you may need to release the bob at a slightly larger angle than what you desire to achieve during the motion.

II. Other Measurements

Measure the lengths and masses needed to calculate $g$ from equation (7). Measure the effective length of the pendulum wire from the pivot point to the top of the bob (which length is slightly longer than that of the physical wire itself) using a metal 2-meter ruler. (Wooden ones warp and shrink.) Measure $L$ from the bottom of the V notch at the pivot point to the top of the mass. Do not rest the ruler on top of the mass as its weight may elongate the wire. Keep the ruler vertical to be than $1/2^\circ$ during the measurement.
Do not disassemble your pendulum to measure the mass of the bob or the wire. Instead, there are additional bobs and wires on the table in the center of the lab which you can weigh and measure.

III. Using the Computers to Do the Tedious Calculations

Calculating \( g \) and doing error propagation with something as messy as equation (7) is, to put it nicely, the perfect job for a computer. We have programmed an Excel worksheet to help you with your calculations. An image of the worksheet is appended at the end of this write-up, and a .xls file is posted on Blackboard, so you can check it out before you get to Lab.

In the Physics 103 folder, double-click on Precision Measurement of g (Rev C).xls to open the worksheet. Since you will be adding your own data to it, you may want to click on File \( \rightarrow \) Save As to allow you to rename and save a copy of the worksheet in the student data folder for your lab period. Then, any time you save the file, it will be saved there under its new name.

Many of the cells in the original worksheet have been “write protected” to keep you from accidentally changing or deleting the parts that do your calculations for you. You can type your values into the yellow, boxed regions, and you can also do any additional calculations to the side or below the ready-made part, which is contained in columns A-Q and rows 1-66.

Let's start by understanding the spreadsheet's logic:

In section (a) of the worksheet, you will want to put something recognizable for a group name and date so that you and others will be able to recognize it later, for instance as printouts become scattered around the lab.

In section (b) of the worksheet, you can enter your raw data for all measured quantities \((L, M, h, r, m, T, \text{ and } \theta_0)\), along with their absolute uncertainties. The worksheet automatically computes the relative (percentage) uncertainty for you.

In section (c), the worksheet shows you the Amplitude Correction Factor \( T/T_0 \) that comes from your pendulum not being a true harmonic oscillator. It also calculates the “corrected period” \( T_0 \) of your pendulum in the limit of very small oscillations.

In section (d), the worksheet calculates the individual geometric correction factors related to your pendulum being a “physical pendulum” rather than an idealized point mass. Each one of the terms A, B, C, D, E, and F corresponds to one of the terms in equation (7). The worksheet also calculates an overall “mass and dimension” correction factor, and combines this with the length \( L \) and the corrected period \( T_0 \) to give you the best value of \( g \) from your measurements according to equation (7).

In section (e), the worksheet calculates the absolute and relative uncertainty in \( g \) from the uncertainties in each of the original measurements, and combines them in quadrature \((i.e., \text{ by taking the square root of the sum of the squares})\) to give the final
uncertainty in $g$ from your experiment (as implied by your original uncertainty estimates).

Start by entering your basic measurements into section (b) of the worksheet. If you do not get a reasonable value for $g$ (between 9.77 and 9.83 m/s$^2$), check for mistakes in your data entry. *Did you actually measure 10 full periods, and not 9 ½ or 10 ½? Did you actually measure the effective length of the pendulum, or only the physical length of the wire? Was the pivot wedge seated in the V-notch so that the pendulum swung freely and reliably?*

Next, think about the numbers reported by the spreadsheet. Do the geometric (mass and dimension) correction factors behave as they should? Does the corrected period give reasonable answers? (When the computer is doing all of the heavy lifting for you, it’s easy for the lab to turn into a “plug and chug” activity, with your brains totally tuned out. Don’t let that happen!)

Next, add your uncertainties to the worksheet. Do they propagate through as they should? Which ones are the biggest sources of error?

Once you have put your numbers in for one set of measurements at $\theta_0 = 10^\circ$ and are satisfied with your results, repeat the experiment with $\theta_0 = 5^\circ$ and with $\theta_0 = 15^\circ$. Your calculated value for $T_0$ should not vary with $\theta_0$; if it does, you have a systematic error somewhere, which you should try to locate.

**IV. Points to Ponder**

These are things you should make a particular point of pondering in your notebook. The AI’s will be looking for these when they check the notebooks.

1. About how big does your $\theta_0$ have to be for the period $T$ of your pendulum to differ from the small amplitude period $T_0$ by 0.1%? By 1%?

2. Which leads to the largest “correction” in your calculation: the fact that your pendulum is not a true harmonic oscillator, or the fact that it is not a simple (point mass) pendulum?

3. In section (b) of the spreadsheet, you estimated errors for all of your measured quantities, and the spreadsheet calculated percentage errors for you. Rank these from most accurate to least accurate.

4. Each of the uncertainties in your measured quantities contributes some uncertainty to the calculation of $g$, as is shown in section (e) of the spreadsheet. Rank these from the largest contribution to the total uncertainty in $g$ to the smallest contribution. Are these the same as your rankings as for question 3? Why or why not?

5. Suppose you could spend five hours and $100 in the lab cutting any one of your measured uncertainties in half. (That is, with 5 hours of your time and $100 you could
decrease the uncertainty in $L, M, h, r, m, T,$ or $\theta_a$ by a factor of two.) Which one would give you the “biggest bang for your buck” in terms of reducing your overall uncertainty in $g$?

6. The premise of question 5 is kind of bogus, in that you probably can’t guarantee that one afternoon and $100 would cut the uncertainty in any one of your variables by a factor of 2. In reality, some of those uncertainties would be easy to improve, some wouldn’t be. So where would you spend your time? What would be the next thing you would do to make a significant improvement in some part of your measurement to reduce your overall uncertainty in $g$? (There’s no one right answer here; this is your chance to think and be creative.)

V. The “Right” Answer

This section violates a fundamental law of Physics 103/105 Lab, namely: there is no “right” answer. But it turns out that what was at the time the world’s best measurement of $g$ was made in Palmer Hall (now Frist Campus Center) in 1963, when the Physics Department was still housed there. Jim Faller, working in room 130, got

$$g = 980.1604 \pm 0.0007 \, \text{cm/sec}^2$$


In 1998, Physics 103/105 labs moved from Palmer Hall to McDonnell Hall. How much do you think Jim Faller’s measurement would have changed had he made it on the second floor of McDonnell Hall? Could his experiment tell the difference? Can yours?

We only have a “right” answer because Faller worked for 3 years and used a very fancy technique. Incidentally, he built a “suitcase” version of his apparatus, which he carried around comparing values of $g$ in standards labs all over the world — London, Paris, Geneva. Anyway, what is the discrepancy between your value of $g$ and Faller’s? Do they agree within the errors?

VI. Report your Values to Your AI

When you are satisfied with your results and understand the uncertainty that the spreadsheet has calculated for you, report your results to your AI, who will tabulate the results for each group, and will give each of you two graphs showing your results plotted along with those of your classmates. At the end of the week, we will collect the values for all of the lab sections and post them in the hallway, and possibly on the course web site.

How do your results compare to those of your classmates? Do your results agree to within your uncertainty? If not, then why? These kinds of “friendly” discussions are what good science is all about.
Calculation Spreadsheet for Precision Measurement of "g"

(Physics 103/105)

NOTE: Input data only into cells in the boxed regions (yellow on the screen). All other entries are calculated automatically. Except for the boxed regions, all the cells in Rows 1 through 64 and in columns A through Q are write-protected. If you need to do calculations other than those that have been provided for, you must use cells outside this region.

(a) Group Name, Date, etc.  
(b) Measurements and Estimated Errors:

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Best Value (m)</th>
<th>+/-</th>
<th>Estimated Error (m)</th>
<th>(Per Cent)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Wire length L</td>
<td>1.95300</td>
<td>+/-</td>
<td>0.00050</td>
<td>0.026%</td>
</tr>
<tr>
<td>Bob mass M</td>
<td>1.20610</td>
<td>+/-</td>
<td>0.00005</td>
<td>0.004%</td>
</tr>
<tr>
<td>Bob length h</td>
<td>0.07200</td>
<td>+/-</td>
<td>0.00050</td>
<td>0.694%</td>
</tr>
<tr>
<td>Bob radius r</td>
<td>0.02550</td>
<td>+/-</td>
<td>0.00025</td>
<td>0.980%</td>
</tr>
<tr>
<td>Wire mass m</td>
<td>0.00370</td>
<td>+/-</td>
<td>0.00010</td>
<td>2.703%</td>
</tr>
<tr>
<td>Period T</td>
<td>2.83390</td>
<td>sec</td>
<td>0.00005</td>
<td>0.002%</td>
</tr>
<tr>
<td>Amplitude $\theta_0$</td>
<td></td>
<td>deg</td>
<td>0.3</td>
<td>2.000%</td>
</tr>
</tbody>
</table>

(c) Calculation of Corrected (i.e., small-amplitude) Period:

Amplitude Correction Factor

$T/T_0 = 1.00430 +/- 0.00017 = 0.017\%$

Corrected period

$T_0 = 2.82177$ sec +/- $0.00049$ sec = $0.017\%$

(d) Calculation of "g":

<table>
<thead>
<tr>
<th>Source of Error</th>
<th>% Error (Original Estimates)</th>
<th>Propagated Errors in Value of &quot;g&quot; (Percent)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Wire length L</td>
<td>0.026%</td>
<td>0.00248 m/sec² 0.0251%</td>
</tr>
<tr>
<td>Bob mass M</td>
<td>0.004%</td>
<td>0.00000 m/sec² 0.0000%</td>
</tr>
<tr>
<td>Bob length h</td>
<td>0.694%</td>
<td>0.00125 m/sec² 0.127%</td>
</tr>
<tr>
<td>Bob radius r</td>
<td>0.980%</td>
<td>0.00001 m/sec² 0.001%</td>
</tr>
<tr>
<td>Wire mass m</td>
<td>2.703%</td>
<td>0.00014 m/sec² 0.014%</td>
</tr>
<tr>
<td>Measured Period T</td>
<td>0.002%</td>
<td>0.00035 m/sec² 0.035%</td>
</tr>
<tr>
<td>Amplitude $\theta_0$</td>
<td>2.000%</td>
<td>0.00333 m/sec² 0.344%</td>
</tr>
</tbody>
</table>

Best Value of "g" (first term multiplied by overall correction factor):

$g = 9.85807$ m/sec²

(e) Uncertainty in "g" -- Propagation of Errors:
LAB #7: COUPLED PENDULA AND NORMAL MODES

BEFORE YOU COME TO LAB:

1. Read Knight's Chapter 14 (Oscillations), as assigned for lecture. Note that the equations describing Simple Harmonic Motion have applications in physics and engineering extending far beyond the simple systems described.

2. Read the lab writeup. Focus on the relationship between the physical phenomena and the equations as you carefully go through the Introduction and then through Appendix I of the writeup.

3. Consider the optional PreLab problem set attached.

A. Introduction

In this week's Lecture and Lab, you will be studying the motion of simple harmonic oscillators. Small departures from equilibrium in almost any system result in a restoring force proportional to the departure, and consequently the motion is Simple Harmonic Motion (SHM). Electrical, acoustical, and optical systems oscillate with SHM, completely analogous to the mass-plus-spring and pendulum systems you’ll be looking at during this Lab. Many physicists use their “physical intuition” about how systems with springs and masses behave to predict how many different systems will act. “Physical intuition” is not an innate human characteristic; a person develops physical intuition with experience. This Lab gives you the opportunity to develop such intuition about SHM in a “simple” mechanical system that exhibits surprising complex behavior.

The main apparatus in this Lab is two “identical” physical pendula (wooden 2×4s with an axle at one end), connected by a weak spring. In the absence of the spring, the two pendula would oscillate at (nearly) the same angular frequency \( \omega = 2\pi f \), with angle \( \theta \) to the vertical obeying \( \theta_i = \theta_{0i} \cos(\omega t + \phi_i) \), with independent amplitudes \( \theta_{0i} \) and phases \( \phi_i \).

Coupling the two pendula by the spring produces two characteristic frequencies, which in turn lead to a complex motion, which is not a simple sinusoid. But the motion can be analyzed as a sum of two sinusoidal motions, each of which obeys the simple equations of SHM, and oscillates at its characteristic frequency. (See Appendix A.)
As you pursue your interest in science and engineering, you will find that a powerful approach to analyzing the time dependence of a complicated system is to look for special “characteristic” frequencies, and to determine the patterns of motion associated with simple sinusoidal oscillations at those frequencies. With these solutions in hand, then any general motion of a “linear” system can be described as a sum of these simple motions. This is the concept of normal modes, which refers to the set of patterns which each leads to simple sinusoidal variations in time.

In this Lab, you should observe various possible patterns of motion of the two-pendulum system, and record carefully descriptions of the patterns of motion that you see. Using a stopwatch, you can determine the frequencies associated with the various patterns which occur. Then, using a computer model which sums and graphs the combined effects of two sinusoids, you can simulate the patterns that you observe, and other patterns as well (for example, the first overtone in a musical instrument).

B. The Apparatus and the Measurements

This apparatus consists of two pendula connected at their centers of mass with a spring, as sketched in Figure 1. Slide the two pendula (2 x 4's) far enough apart that the spring is stretched when at rest. When you swing the pendula, the spring should never collapse completely. If it does, restart the pendula with smaller amplitudes, and/or slide the pendula farther apart.

Displace one pendulum while holding the other fixed, and then let both go free at the same time. The motion is complicated! At first one pendulum oscillates, but after a while its oscillations become small and the other pendulum oscillates. Later, the first pendulum oscillates again and the second does not. And then, this cycle of “transference of oscillation” repeats over and over (until friction damps all oscillations to zero).

Next, displace both pendula and let them go. You should find special combinations of the initial displacements such that there is no “transference of oscillation”, and both pendula oscillate with
the same frequency. How many different ways can you generate these “normal modes” of oscillation?

Using a stopwatch, measure the frequencies of the pendula without the spring, and then the frequencies of the normal modes that you have discovered when the spring is attached.

After you have analyzed the simple patterns of motion, again displace one pendulum while holding the other one fixed. Then release them simultaneously. Describe the resulting motion. Using the stopwatch, measure any relevant frequencies, and relate these to the frequencies of the normal modes they you previously observed.

Make a VideoPoint movie of the complex motion, using a capture rate of 5 frames per second. (Since you will be interested mainly in frequencies, there is no need to include a meter stick in the field of view.) Make sure that the video covers at least two (2) complete cycles of the “transference of oscillation” (and so includes 5 times at which the left pendulum has minimal amplitude of oscillation). Digitize the positions of some identifiable point near the bottom of each of the pendula. Make plots of horizontal position of these points versus time.

The challenge now is to extract the frequencies and amplitudes of the normal modes from your plots. You will do this by varying the parameters in a computer model of your experiment until you obtain a good match between your plots of position vs. time and the computer simulation.

C. Computer Modeling of Your Results

An Excel program, Normal_Modes_Modeling, can be found in your Physics 103 folder (and on the Blackboard). It provides a way of confirming that two sinusoidal normal modes can generate the complex behavior that you observed with the two pendulums.

The program calculates the functions

\[ \theta_1(t) = u_0 \cos(\omega(t + \phi)) + v_0 \cos(\omega t + \phi), \]
\[ \theta_2(t) = u_0 \cos(\omega(t + \phi)) - v_0 \cos(\omega t + \phi), \]

found in eqs. (7) and (8) of the Appendix.
The figure on p. 49 shows an example Excel screen. Amplitudes, frequencies and phases can be changed at will. Note also that you may need to change the maximum value of the range of time plotted in order to see the entire behavior.

Your plots of horizontal position $x$ vs. time of points on your two pendula should have the same form as the computer plots of $\theta_1(t)$ and $\theta_2(t)$ since $x = x_0 + D \sin \theta \approx x + D \theta$, where $D$ is the vertical distance from the pivot to the point you digitized. Adjust the input parameters (in yellow cells) in the Excel program until the computer plots match your data plots. Since the vertical scale of the plots is arbitrary, you can leave parameter $u_0$ (or $v_0$) fixed to speed up the process of “fitting” the parameters. Another trick is to leave $\phi_u$ fixed at first, while adjusting parameters $v_0$ and $\phi_v$ until the computer pattern matches that of your data, except for an offset in time. You can determine the frequencies $f_u$ and $f_v$ without determining the phase $\phi_u$, but if you wish to obtain the best match between the computer plots and your data, make the final adjustment of $\phi_u$ while keeping the difference $\phi_u - \phi_v$ constant.

What are the uncertainties on the frequencies $f_u$ and $f_v$ that you determine by this “fitting” procedure? That is, how much can you change these parameters in the computer model such that the match between the model and your data is “good enough?”

**D. Optional Computer Modeling**

You can download the Excel program from the Blackboard and use it to model other systems that involve the sum (or difference) between two simple harmonic oscillations.

In the following, you may want to make the amplitude of the higher-frequency term smaller than that of the fundamental.

(a) Look at two frequencies which are exactly a factor of two apart. These are most relevant to such instruments as the flute and the organ, in which the overtones tend to be almost exact multiples of the fundamental note being played.

(b) Look at two frequencies which are almost, but not quite, a factor of two apart. (Say, with a frequency ratio of 2.2 to 1.) Such waveforms are perhaps relevant to the sound produced by a saxophone, in which the tapered bore causes the overtones to not be exact multiples of the fundamental note.

(c) What about non-integer ratios of frequencies? Think about what period of time makes such a system return to its initial state. (Use simple integer ratios first, such as 3:2.)
Appendix: Coupled Oscillations

Consider the case of the two pendula coupled with a spring at their centers of mass, as shown in Fig. 1. We suppose that the distances $L$ from the pivots to the centers of mass are the same, and that the masses $m$ and the moments of inertia $I$ about the pivots are the same for the two pendula. Positive angles $\theta$ correspond to counterclockwise displacements from the vertical.

There are two torques on each pendulum. The weight of a pendulum gives a torque, which tries to restore the pendulum to vertical,

$$\tau_{i,w} = -m_i g l \sin \theta \approx -m_i g l \theta,$$

using the small-angle approximation. The spring provides a restoring torque on the left pendulum which acts to bring the separation $L_s$ between the centers of mass of the pendula to the unstretched length of the spring, $L_0$. Assuming that $L_0$ equals the distance between the centers of mass of the pendula when vertical, the force on the left pendulum due to the spring is

$$F_s = k (L_s - L_0) \approx k L (\theta_1 - \theta_2),$$

and the torque on the left pendulum due to the spring is

$$\tau_s \approx LF_s \approx -k L (\theta_1 - \theta_2).$$

The restoring torque on the right pendulum is equal in magnitude, but in the opposite direction.

Newton’s law in angular variables applied to each pendulum gives the following equations of motion:

$$I \ddot{\theta}_1 = I \frac{d^2 \theta_1}{dt^2} = I \ddot{\theta}_1 = -mgL \dot{\theta}_1 - kL (\theta_1 - \theta_2), \quad (1)$$

$$I \ddot{\theta}_2 = I \frac{d^2 \theta_2}{dt^2} = I \ddot{\theta}_2 = -mgL \dot{\theta}_2 + kL (\theta_1 - \theta_2). \quad (2)$$

Neither of these equations describes simple harmonic motion because of the spring coupling terms. However, then by adding and subtracting eqs. (1) and (2) we obtain two new equations each of which describes simple harmonic motion.

$$I \left( \ddot{\theta}_1 + \ddot{\theta}_2 \right) = -mgL (\dot{\theta}_1 + \dot{\theta}_2), \quad (3)$$

and

$$I \left( \ddot{\theta}_1 - \ddot{\theta}_2 \right) = -(mgL + 2kL^2) (\dot{\theta}_1 - \dot{\theta}_2). \quad (4)$$

Equation (3) is an equation for simple harmonic motion in the variable

$$u = \theta_1 + \theta_2,$$

such that

$$u(t) = 2u_0 \cos (\omega_u t + \phi_u), \quad \text{where} \quad \omega_u^2 = \frac{mgL}{I}. \quad (5)$$

Similarly, equation (4) describes simple harmonic motion in the variable

$$v = \theta_1 - \theta_2,$$

such that

$$v(t) = 2v_0 \cos (\omega_v t + \phi_v), \quad \text{where} \quad \omega_v^2 = \frac{mgL + 2kL^2}{I}. \quad (6)$$

The solutions $u(t)$ and $v(t)$ are called normal modes = motions in which both pendula move at the same frequency. The normal mode $u(t)$ is excited when both pendula are displaced equally in the same direction. The spring then has no effect. The normal mode $v(t)$ is excited by starting the pendula with equal and opposite displacements. The frequency for this mode is higher.

---

1 The factor of 2 in $u(t)$ and $v(t)$ is inserted to make eqs. (7) and (8) look simpler.
because this motion excites the spring, which increases the forces and torques on the pendula, which then move faster.

The variables that we observe directly are $\theta_1(t)$ and $\theta_2(t)$,

$$\theta_1(t) = \frac{u + v}{2} = u_0 \cos(\omega t + \phi_u) + v_0 \cos(\omega t + \phi_v),$$

$$\theta_2(t) = \frac{u - v}{2} = u_0 \cos(\omega t + \phi_u) - v_0 \cos(\omega t + \phi_v).$$

Using some trig identities, eqs. (7) and (8) can be rewritten as

$$\theta_1(t) = 2(u_0 + v_0)\cos(\omega t + \phi_u)\cos(\omega t + \phi_v) - 2(u_0 - v_0)\sin(\omega t + \phi_u)\sin(\omega t + \phi_v),$$

$$\theta_2(t) = -2(u_0 + v_0)\sin(\omega t + \phi_u)\sin(\omega t + \phi_v) + 2(u_0 - v_0)\cos(\omega t + \phi_u)\cos(\omega t + \phi_v),$$

where $\omega_+ = \frac{\omega_u + \omega_v}{2}$, $\phi_+ = \frac{\phi_u + \phi_v}{2}$, $\omega_- = \frac{\omega_v - \omega_u}{2}$, $\phi_- = \frac{\phi_u - \phi_v}{2}$.

These complicated forms can be thought of (or heard as!) an oscillation at the average frequency $\omega_+$ that is modulated by an oscillation at the much lower frequency $\omega_-$. As example of this is shown in the figure below, for the case that $u_0 = v_0$.

In acoustics, when the frequency difference $\omega_-$ is very small, the sound you hear seems to come in pulses or “beat”, and the difference $f_v - f_u = \omega_v / 2\pi - \omega_u / 2\pi$ is call the “beat frequency.”
1. Consider a simple pendulum consisting of a mass \( m \) suspended on a string of length \( L \).

   (a) What is the pendulum's natural frequency if \( L = 1 \text{ m} \)?

   (b) What length \( L \) for a clock pendulum would make the clock “tick” once every second, if the tick occurs every time the clock's pendulum passes through its equilibrium position?

2. Two identical carts are placed on a frictionless air track, so that they are free to move along a horizontal line. Weak springs of negligible mass are used to join the two cars and to connect each of the cars with a fixed point its end of the air track. The three springs have identical spring constants \( k \). Each car has a mass \( M \).

   (a) What will be the frequency of motion if each cart is moved some distance \( D \) to the right of its equilibrium position, and they are simultaneously released from that position? (Hint: Think of the springs, and use the similarity of the two cart's situations.)

   (b) What will be the frequency of motion if, instead of the above, one cart is moved a distance \( D \) to the right of its equilibrium position, and the other cart is moved a distance \( D \) to the left?
LAB #8: THE SPEED OF SOUND
AND SPECIFIC HEATS OF GASES

Introduction

This week you will measure the velocity of sound in a gas, and you will weigh the
gas in order to find its density. These measurements will lead to a determination of
$C_P/C_V$, the ratio of specific heats at constant pressure and constant volume, and thus
should allow you to determine the molecular structure of the gas. It is a beautiful
example of how measurements of macroscopic lengths, masses, and forces provide
information about molecules having sizes and masses of $10^{-10}$ meters and $10^{-23}$ grams!

Let's quickly review how these quantities relate -- that is, how the speed of sound
ultimately relates to degrees of freedom and specific heat. The speed $c$ of longitudinal
waves is given by (see Appendix A for a derivation)
\[ c = \sqrt{B/\rho}, \]
where $\rho$ is the density of the medium, and $B$ is the bulk modulus defined by the
relationship
\[ B = \frac{\Delta P}{\Delta \rho / \rho} = -\frac{\Delta P}{\Delta V / V} \]
(noting that changes in density and
volume have opposite signs). The bulk modulus is a property of a substance: it describes
the fractional change in the volume $V$ when the pressure is increased by an amount $\Delta P$.

Now consider sound traveling in an ideal gas. If the temperature of the gas were
unaffected by a sound wave, then the ideal gas law, $PV = NRT$, could be differentiated
as $V\Delta P + P\Delta V = 0$, such that $-\Delta P / (\Delta V / V) = P$.

However, it is not correct for a gas that $B = P$. Sound waves propagate as a series
of compressions and expansions, which change the local kinetic energy of the gas. Since
temperature is a measure of the internal energy of a system, temperature is not constant
during a sound wave. But, the variations in density of the gas take place so rapidly that
there is no time for heat transfer from one part of the medium to another. A process in
which there is no heat flow is called adiabatic. For an adiabatic process involving a gas
the quantity $PV^\gamma$ remains constant, where $\gamma$ is the ratio $C_P/C_V$, as shown in Appendix B.
In this case, $V\Delta P + \gamma P\Delta V = 0$, and $B = -\Delta P / (\Delta V / V) = \gamma P$.
From this it follows that the speed of sound is given by
\[ c = \sqrt{\frac{\gamma P}{\rho}}. \]
Gas Safety

Tanks of various gases will be available in the lab. Choose one of these for your measurement of the speed of sound and, of course, use the same gas for measurement of the density. The tanks contain gas at high pressure: *do not try to move the tanks*. Every tank has three valves: one on the throat of the bottle, which allows gas to enter a large reduction valve in the regulator, which bleeds the gas slowly out of a small needle valve to which the rubber tubing is attached. You need to use only the needle valve. The others have been adjusted: *do not tamper with them*. The pressure has been set high enough to give a flow that will fill your flask in a reasonable time. If someone should increase the pressure it could cause a flask to blow up! When you open the needle valve you should feel a gentle breeze of gas flowing out of the rubber tube when held near your lips. Keep the needle valve closed when you are not taking gas, open it when you need some.

Velocity of Sound

The apparatus for measuring the speed of sound is a vertical cylinder of gas. The length of the column of gas is adjusted by changing the height of a metal reservoir of oil. A loudspeaker is attached to the top of the cylinder, and it generates sound from an electrical audio oscillator. The loudspeaker also responds to sound vibrations (like a microphone) and thus the sound waves set up in the cylinder of gas affect it also. This action is detected by a meter. When the cylinder is in resonance you will get a significant change in the reading of the meter included in the speaker circuit.

As a preliminary step, turn on the oscillator at a convenient frequency (1000 cycles/sec) and let the oil descend from the top down about 60 cm. Watch the meter and listen to the sound. You should be able to find several positions of the oil level at which
resonance occurs. You will want to adjust the output level of the oscillator so that the meter reading is near the end of the scale when the system is off resonance. When the system is at a resonance, the meter reading should change by about 10 or 15%. You might find that a different frequency (10-20%) will give a stronger indication of resonance. Explore a bit.

You are now ready to fill the cylinder with gas from one of the tanks. Note that you will need to flush out the air (or other gas) previously there. Raise the oil as high as possible in the transparent column to minimize the volume of air trapped at its top. Connect your flask of gas to the oil reservoir, so that as the gas enters the reservoir it creates a higher pressure there, which further raises the level of the oil in the column.

Be sure to open and close the valves in an order such the pressure in the system never gets too high, and causes the oil to overflow the top of the column.

Lower the oil level from the top and note the approximate location of the first three resonances. Then raise the oil slowly through each resonance. (Upward motion makes is easier to determine the level of oil, as you will discover on trying it both ways.) Find the position of resonance as accurately as possible.

Compute the speed of sound from the spacing between resonances and the frequency of the audio oscillator.

Figure from Tipler's 4th Edition (p. 492) – The first four harmonics of standing waves on a string fixed at both ends.
Density of the Gas

The density is found by weighing a known volume of the gas at atmospheric pressure. Two flasks of equal size are provided, one coated with plastic and the other clear.

Evacuate the coated flask with the vacuum pump (you can tell when this is achieved when a sharp clacking sound of the pump replaces the initial slurping sound). Weigh the evacuated flask (be careful not to drop it, the plastic coating has been put on to minimize hazard). Then fill the flask with your gas and reweigh.

Use the clear flask to find the volume by filling it with water to the proper level (remember the rubber stopper in the plastic coated flask). Measure the volume of water.

You can check your measurement of the density by comparing to the density of an ideal gas of particular molar mass: \( p V = n R T \) and so \( M n / V = M p / R T \), where \( M \) is the molar mass. Consider such gases as Ar, N\(_2\), and CO\(_2\). What density does the ideal gas law predict?

From the measured density and speed of sound for your gas, and the pressure of the atmosphere in the lab, determine the value of \( \gamma \) for your gas.

Tips on Technique

- A good way find a resonance position is for one person to slowly raise the oil level while another records the meter readings. The resonance position can be found by graphing the meter reading versus position.

- You must measure the change in weight (few grams) of the evacuated and filled flask, which can be done by moving the rider on the balance. Be sure that the weights in the balance pan are not changed while you fill the flask with gas.

- To fill the flask, open the needle valve, repeat the lip test, and if a gentle flow is found attach the hose to your flask and open the stopcock. It will be filled when the hissing noise at the needle valve stops. Shut the stopcock. Shut the needle valve and remove the tubing. The pressure in the flask is slightly above atmospheric. Open the stopcock slightly and gas will hiss out allowing the pressure to drop to normal. Weigh the filled flask. After a minute, open the stopcock again briefly and close. Reweigh. Repeat after another minute. Reweigh. If the weight has not changed again you are finished. If it has, repeat again. Why does the weight change at all?

What Gas Did You Use?

The tanks will be labeled so that they can be distinguished, but the labels indicating what gases they contain will be hidden. Some time into the lab your AI will provide you with a list of gases which might have been in the tanks. Can you determine from your measurements of density and \( \gamma \) which gas you used? How confident are you? \( I.e., \) what's your error, and how well can you distinguish between monatomic, diatomic, and polyatomic gases?
Appendix A: Wave Equation for Sound

Sound waves cause small changes in the density $\rho$ and pressure $P$ of the gas. We write $\rho = \rho_0 + \rho_1$ and $P = P_0 + P_1$ where the perturbations $\rho_1$ and $P_1$ are small compared to the equilibrium values $\rho_0$ and $P_0$. Recalling the definition of the bulk modulus,

$$ B = \frac{\Delta P}{\Delta \rho / \rho} = -\frac{\Delta P}{\Delta V / V}, $$

we see that the small changes in density and pressure are related by

$$ P_1 = \Delta P = B \frac{\Delta \rho}{\rho} = B \frac{\rho_1}{\rho_0}. $$

For simplicity, we suppose that the sound wave propagates along the $x$-axis.

In the absence of the sound wave the average velocity of the gas molecules is zero. The sound wave imparts an average velocity $v$ (in the $x$-direction) to the molecules in a small volume $dx \, dy \, dz$. The mass in this volume is

$$ \rho \, dx \, dy \, dz \approx \rho_0 \, dx \, dy \, dz, $$

and the force on this volume due to the pressure difference on its faces at $x$ and $x + dx$ is

$$ F = [P(x) - P(x + dx)] \, dy \, dz = -\frac{dP_1}{dx} \, dx \, dy \, dz. $$

Newton’s equation of motion for this small mass of molecules is therefore,

$$ F = ma \approx \rho_0 dx \, dy \, dz \frac{dv}{dt} = -\frac{dP_1}{dx} \, dx \, dy \, dz, \quad i.e., \quad \frac{dv}{dt} \approx -\frac{1}{\rho_0} \frac{dP_1}{dx} = -\frac{B}{\rho_0} \frac{d\rho_1}{dx}. $$

The density and the velocity are related in another way, because the density of the small volume can only change if the velocity is different at its two $x$-faces. In particular, the length of the small volume changes from $dx$ to

$$ dx' = dx + [v(x + dx) - v(x)] \, dt = dx + \frac{dv}{dx} \, dx \, dt = dx \left(1 + \frac{dv}{dx} \right) $$
during time $dt$. The resulting change in the density during time $dt$ is

$$ d\rho = d\rho_1 = \frac{m}{dx' \, dy \, dz} - \frac{m}{dx \, dy \, dz} = \frac{m}{dx \, dy \, dz} \left(1 + \frac{dv}{dx} \right) \left(1 + \frac{dv}{dx} \right) \approx -\rho_0 \frac{dv}{dx} \, dt, $$

and hence

$$ \frac{d\rho_1}{dt} \approx -\rho_0 \frac{dv}{dx} $$

(equation of “continuity”). Taking the time derivative of the equation of motion for $dv/\, dt$, we obtain the wave equation,

$$ \frac{d^2v}{dt^2} \approx -\frac{B}{\rho_0^2} \frac{d\rho_1}{dx \, dt} \approx -\frac{B}{\rho_0^2} \frac{d^2v}{dx^2} $$

(wave equation).

For a travelling wave, $v = f(x - ct)$, we find that $c^2 \frac{d^2v}{dt^2} = \frac{d^2v}{dx^2}$, so the speed of sound is given by

$$ c = \sqrt{\frac{B}{\rho_0}} $$

(Newton, 1687, with $B = P$; Laplace, 1816, noted that $B = \gamma P$).
Appendix B: Adiabats of an Ideal Gas

The First Law of Thermodynamics expresses conservation of energy for a gas as
\[ \Delta U = Q - W, \]
where \( \Delta U \) is the change in the internal energy \( U \) of the gas when energy \( Q \) flows into the gas in the form of heat, and the gas does work \( W \) on the external system. The gas only does work if its volume \( V \) changes, in which case
\[ W = \int P \, dV, \]
where in general, the pressure \( P \) changes as the volume changes. If \( N \) moles of a gas are heated at constant volume, the change in internal energy is given by
\[ \Delta U_v = Q = N C_v \Delta T, \]
Where \( C_v \) is the molar heat capacity at constant volume, and \( \Delta T \) is the resulting change in temperature of the gas. The heat capacity of an ideal gas is independent of temperature, such that the internal energy of a gas at absolute temperature \( T \) is given by
\[ U = N C_v T. \]

Of course, an ideal gas also obeys the ideal gas law,
\[ PV = NRT, \]
where \( R = 8.31 \text{ J/(mole-K)} \) is the ideal gas constant.

In an adiabatic process there is no heat flow, by definition. Hence, in an adiabatic process that makes only small changes in the parameters of the gas, the First Law can be written
\[ N C_v \, dT = dU = -dW = -P \, dV, \]
And the ideal gas law tells us that
\[ N \, dT = \frac{P \, dV + V \, dP}{R}. \]

Combining these equations, we find that
\[ 0 = \frac{dP}{P} + \frac{C_v + R}{C_v} \frac{dV}{V} \equiv \frac{dP}{P} + \gamma \frac{dV}{V}, \]
where
\[ \gamma = \frac{C_v + R}{C_v} = \frac{C_p}{C_v} \]
is the ratio of specific heat at constant pressure to that at constant volume. Integarting, we obtain \( a = \ln P + \gamma \ln V, \) and hence
\[ PV^\gamma = e^a = \text{constant}. \]

For completeness, we demonstrate that the molar heat capacity \( C_p \) at constant pressure is related by
\[ C_p = C_v + R. \]
If the gas is heated at constant pressure, then the heat required is \( Q = N C_p \Delta T, \) the work done by the gas is \( W = P \Delta V = N R \Delta T, \) and the change in the internal energy of the gas is \( \Delta U = N C_v \Delta T. \) Inserting these relations in the First Law, we obtain
\[ N C_v \Delta T = \Delta U = Q - W = N C_p \Delta T - N R \Delta T, \]
which confirms that \( C_p = C_v + R. \)
REFERENCE INFORMATION

The following pages contain general information which you may find useful. They include:

- A table from Tipler, on specific heats of gases. Values of γ may be derived from this data.
- A table of densities of various gases, directly relevant to your calculation of v.
- A Periodic Table of the Elements, giving the atomic weights of the various elements. This will be useful if you want to consider gas densities from the point of view of the ideal gas law, \( PV = NRT \).

You may recall that 1 atm = 101.3 kPa = 76.00 cm Hg.

Table 18-3 from Tipler (5th edition):

**Molar Heat Capacities in J/mol·K of Various Gases at 25°C**

<table>
<thead>
<tr>
<th>Gas</th>
<th>( c'_p )</th>
<th>( c'_v )</th>
<th>( c'_v/R )</th>
<th>( c'_p - c'_v )</th>
<th>( (c'_p - c'_v)/R )</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Monatomic</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>He</td>
<td>20.79</td>
<td>12.52</td>
<td>1.51</td>
<td>8.27</td>
<td>0.99</td>
</tr>
<tr>
<td>Ne</td>
<td>20.79</td>
<td>12.68</td>
<td>1.52</td>
<td>8.11</td>
<td>0.98</td>
</tr>
<tr>
<td>Ar</td>
<td>20.79</td>
<td>12.45</td>
<td>1.50</td>
<td>8.34</td>
<td>1.00</td>
</tr>
<tr>
<td>Kr</td>
<td>20.79</td>
<td>12.45</td>
<td>1.50</td>
<td>8.34</td>
<td>1.00</td>
</tr>
<tr>
<td>Xe</td>
<td>20.79</td>
<td>12.52</td>
<td>1.51</td>
<td>8.27</td>
<td>0.99</td>
</tr>
<tr>
<td><strong>Diatomic</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>N₂</td>
<td>29.12</td>
<td>20.80</td>
<td>2.50</td>
<td>8.32</td>
<td>1.00</td>
</tr>
<tr>
<td>H₂</td>
<td>28.82</td>
<td>20.44</td>
<td>2.46</td>
<td>8.38</td>
<td>1.01</td>
</tr>
<tr>
<td>O₂</td>
<td>29.37</td>
<td>20.98</td>
<td>2.52</td>
<td>8.39</td>
<td>1.01</td>
</tr>
<tr>
<td>CO</td>
<td>29.04</td>
<td>20.74</td>
<td>2.49</td>
<td>8.30</td>
<td>1.00</td>
</tr>
<tr>
<td><strong>Polyatomic</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>CO₂</td>
<td>36.62</td>
<td>28.17</td>
<td>3.39</td>
<td>8.45</td>
<td>1.02</td>
</tr>
<tr>
<td>N₂O</td>
<td>36.90</td>
<td>28.39</td>
<td>3.41</td>
<td>8.51</td>
<td>1.02</td>
</tr>
<tr>
<td>H₂S</td>
<td>36.12</td>
<td>27.36</td>
<td>3.29</td>
<td>8.76</td>
<td>1.05</td>
</tr>
</tbody>
</table>
## DENSITY AND SPECIFIC GRAVITY OF GASES AND VAPORS

<table>
<thead>
<tr>
<th>Name</th>
<th>Formula</th>
<th>Density ( g/1^\circ C ) (760 mm)</th>
<th>Density ( lb./ft.^3 ) (32°F, 1 atm.)</th>
<th>Specific gravity (Air = 1)</th>
<th>Specific gravity (( O_2 = 1 ))</th>
</tr>
</thead>
<tbody>
<tr>
<td>Acetylene</td>
<td>( \text{C}_2\text{H}_2 )</td>
<td>1.173</td>
<td>0.0732</td>
<td>0.8073</td>
<td>0.8208</td>
</tr>
<tr>
<td>Air</td>
<td>( \text{N}_2 )</td>
<td>0.770</td>
<td>0.4813</td>
<td>0.5963</td>
<td>0.5395</td>
</tr>
<tr>
<td>Argon</td>
<td>( \text{A} )</td>
<td>1.957</td>
<td>1.1135</td>
<td>1.3766</td>
<td>1.2482</td>
</tr>
<tr>
<td>Arsenic fluoride</td>
<td>( \text{AsF}_3 )</td>
<td>3.484*</td>
<td>2.175*</td>
<td>2.695*</td>
<td>2.438*</td>
</tr>
<tr>
<td>Arsenic hydride</td>
<td>( \text{AsH}_3 )</td>
<td>2.99*</td>
<td>1.87*</td>
<td>2.31*</td>
<td>2.09*</td>
</tr>
<tr>
<td>Boron fluoride</td>
<td>( \text{BF}_3 )</td>
<td>2.673</td>
<td>1.606</td>
<td>1.187*</td>
<td>1.170</td>
</tr>
<tr>
<td>Butane (( \text{C}<em>4\text{H}</em>{10} ))</td>
<td>1.9759</td>
<td>1.2341</td>
<td>1.5290</td>
<td>1.3843</td>
<td>1.3341</td>
</tr>
<tr>
<td>Carbon dioxide</td>
<td>( \text{CO}_2 )</td>
<td>1.294</td>
<td>0.7906</td>
<td>0.9671</td>
<td>0.8750</td>
</tr>
<tr>
<td>Carbon monoxide</td>
<td>( \text{CO} )</td>
<td>2.73</td>
<td>1.70</td>
<td>2.19</td>
<td>2.00</td>
</tr>
<tr>
<td>Carbon tetrachloride</td>
<td>( \text{CCl}_4 )</td>
<td>3.091</td>
<td>1.935</td>
<td>2.39*</td>
<td>2.16*</td>
</tr>
<tr>
<td>Chlorine</td>
<td>( \text{Cl}_2 )</td>
<td>3.89</td>
<td>2.425</td>
<td>3.01</td>
<td>2.72</td>
</tr>
<tr>
<td>Chlorine dioxide</td>
<td>( \text{Cl}_2 )</td>
<td>3.89</td>
<td>2.425</td>
<td>3.01</td>
<td>2.72</td>
</tr>
<tr>
<td>Chlorine monoxide</td>
<td>( \text{Cl}_2 )</td>
<td>3.89</td>
<td>2.425</td>
<td>3.01</td>
<td>2.72</td>
</tr>
<tr>
<td>Cyanogen</td>
<td>( \text{CN}_2 )</td>
<td>2.33*</td>
<td>1.458</td>
<td>1.806*</td>
<td>1.63*</td>
</tr>
<tr>
<td>Dimethylamine</td>
<td>( \text{CH}_3\text{CH}_2\text{NH} )</td>
<td>6.74*</td>
<td>0.421*</td>
<td>5.21*</td>
<td>4.72*</td>
</tr>
<tr>
<td>Germanium hydride</td>
<td>( \text{GeH}_4 )</td>
<td>3.420</td>
<td>2.135</td>
<td>2.645</td>
<td>2.393</td>
</tr>
<tr>
<td>Germanium tetrachloride</td>
<td>( \text{GeCl}_4 )</td>
<td>0.1784</td>
<td>0.1114</td>
<td>0.13804</td>
<td>0.1248</td>
</tr>
<tr>
<td>Helium</td>
<td>( \text{He} )</td>
<td>0.00865</td>
<td>0.00510</td>
<td>0.00622</td>
<td>0.00622</td>
</tr>
<tr>
<td>Hydrogen</td>
<td>( \text{H}_2 )</td>
<td>2.108</td>
<td>1.275</td>
<td>1.819</td>
<td>1.701</td>
</tr>
<tr>
<td>Hydrogen bromide</td>
<td>( \text{HBr} )</td>
<td>1.639</td>
<td>1.0233</td>
<td>1.2678</td>
<td>1.1471</td>
</tr>
<tr>
<td>Hydrogen chloride</td>
<td>( \text{HCl} )</td>
<td>5.789</td>
<td>3.814</td>
<td>4.7761</td>
<td>4.0310</td>
</tr>
<tr>
<td>Hydrogen iodide</td>
<td>( \text{HI} )</td>
<td>2.670</td>
<td>1.637</td>
<td>2.568</td>
<td>2.592</td>
</tr>
<tr>
<td>Hydrogen sulfide</td>
<td>( \text{H}_2\text{S} )</td>
<td>1.593</td>
<td>0.9665</td>
<td>1.190</td>
<td>1.077</td>
</tr>
<tr>
<td>Hydrogen telluride</td>
<td>( \text{H}_2\text{Te} )</td>
<td>5.81</td>
<td>3.836</td>
<td>4.49</td>
<td>4.07</td>
</tr>
<tr>
<td>Krypton</td>
<td>( \text{Kr} )</td>
<td>3.708</td>
<td>2.320</td>
<td>2.945</td>
<td>2.595</td>
</tr>
<tr>
<td>Methyl iodine</td>
<td>( \text{CH}_3\text{I} )</td>
<td>1.396</td>
<td>0.9715</td>
<td>1.080</td>
<td>0.9769</td>
</tr>
<tr>
<td>Methyl chloride</td>
<td>( \text{CH}_3\text{Cl} )</td>
<td>2.3067</td>
<td>1.441</td>
<td>1.6141</td>
<td>1.5141</td>
</tr>
<tr>
<td>Methyl ether</td>
<td>( \text{CH}_3\text{CH}_2\text{O} )</td>
<td>2.108</td>
<td>1.386</td>
<td>1.418</td>
<td>1.364</td>
</tr>
<tr>
<td>Methyl fluoride</td>
<td>( \text{CH}_3\text{F} )</td>
<td>1.845</td>
<td>0.9846</td>
<td>1.0915</td>
<td>1.081</td>
</tr>
<tr>
<td>Neon</td>
<td>( \text{Ne} )</td>
<td>0.90055</td>
<td>0.5621</td>
<td>0.69682</td>
<td>0.63004</td>
</tr>
<tr>
<td>Nitric oxide</td>
<td>( \text{N}_2\text{O} )</td>
<td>1.3402</td>
<td>0.8465</td>
<td>0.9378</td>
<td>0.9618</td>
</tr>
<tr>
<td>Nitrogen</td>
<td>( \text{N}_2 )</td>
<td>1.25055</td>
<td>0.7807</td>
<td>0.96724</td>
<td>0.87510</td>
</tr>
<tr>
<td>Nitrogen (atm.)</td>
<td>( \text{N}_2 )</td>
<td>1.2588</td>
<td>0.8746</td>
<td>0.9721</td>
<td>0.87510</td>
</tr>
<tr>
<td>Nitrosyl fluoride</td>
<td>( \text{NO}_2 )</td>
<td>2.176*</td>
<td>1.355*</td>
<td>1.683*</td>
<td>1.523*</td>
</tr>
<tr>
<td>Nitrosyl fluoride</td>
<td>( \text{NO}_2 )</td>
<td>2.176*</td>
<td>1.355*</td>
<td>1.683*</td>
<td>1.523*</td>
</tr>
<tr>
<td>Nitric oxide</td>
<td>( \text{NO} )</td>
<td>1.972</td>
<td>1.235</td>
<td>1.5297</td>
<td>1.3840</td>
</tr>
<tr>
<td>Nitric acid</td>
<td>( \text{HNO}_3 )</td>
<td>2.57*</td>
<td>1.875</td>
<td>2.328*</td>
<td>2.198*</td>
</tr>
<tr>
<td>Nitrous oxide</td>
<td>( \text{NO} )</td>
<td>2.90*</td>
<td>1.81</td>
<td>2.24</td>
<td>2.03</td>
</tr>
<tr>
<td>Oxygen</td>
<td>( \text{O}_2 )</td>
<td>1.42204</td>
<td>0.80921</td>
<td>1.10527</td>
<td>1.0000</td>
</tr>
<tr>
<td>Phosphine</td>
<td>( \text{PH}_3 )</td>
<td>2.524</td>
<td>1.556</td>
<td>1.9292</td>
<td>1.702</td>
</tr>
<tr>
<td>Phosphorus fluoride</td>
<td>( \text{PF}_3 )</td>
<td>3.907*</td>
<td>2.439*</td>
<td>3.022*</td>
<td>2.734*</td>
</tr>
<tr>
<td>Phosphorus pentoxide</td>
<td>( \text{PO}_5\text{F}_7 )</td>
<td>4.8</td>
<td>0.30</td>
<td>3.7</td>
<td>3.4</td>
</tr>
<tr>
<td>Hydrogen fluoride</td>
<td>( \text{HF} )</td>
<td>2.81</td>
<td>1.62</td>
<td>2.049</td>
<td>1.856</td>
</tr>
<tr>
<td>Hydrogen sulfite</td>
<td>( \text{H}_2\text{S} )</td>
<td>1.593</td>
<td>0.9665</td>
<td>1.190</td>
<td>1.077</td>
</tr>
<tr>
<td>Oxygen</td>
<td>( \text{O}_2 )</td>
<td>1.42204</td>
<td>0.80921</td>
<td>1.10527</td>
<td>1.0000</td>
</tr>
<tr>
<td>Phosphorus fluoride</td>
<td>( \text{PF}_3 )</td>
<td>3.907*</td>
<td>2.439*</td>
<td>3.022*</td>
<td>2.734*</td>
</tr>
<tr>
<td>Phosphorus pentoxide</td>
<td>( \text{PO}_5\text{F}_7 )</td>
<td>4.8</td>
<td>0.30</td>
<td>3.7</td>
<td>3.4</td>
</tr>
<tr>
<td>Propane</td>
<td>( \text{C}_3\text{H}_6 )</td>
<td>2.0066</td>
<td>1.254</td>
<td>1.551</td>
<td>1.407</td>
</tr>
</tbody>
</table>

* Temperature not stated. Probably 20°C.
† Both butane and air at 710 mm.
<table>
<thead>
<tr>
<th>1</th>
<th>2</th>
<th>3</th>
<th>4</th>
<th>5</th>
<th>6</th>
<th>7</th>
<th>8</th>
<th>9</th>
<th>10</th>
<th>11</th>
<th>12</th>
</tr>
</thead>
<tbody>
<tr>
<td>H</td>
<td>Li</td>
<td>Be</td>
<td>B</td>
<td>C</td>
<td>N</td>
<td>O</td>
<td>F</td>
<td>Ne</td>
<td>Na</td>
<td>Mg</td>
<td>Al</td>
</tr>
<tr>
<td>11 Na</td>
<td>12 Mg</td>
<td>13 Al</td>
<td>14 Si</td>
<td>15 P</td>
<td>16 S</td>
<td>17 Cl</td>
<td>18 Ar</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

| 19 K | 20 Ca | 21 Sc | 22 Ti | 23 V | 24 Cr | 25 Mn | 26 Fe | 27 Co | 28 Ni | 29 Cu | 30 Zn | 31 Ga | 32 Ge | 33 As | 34 Se | 35 Br |
| 39.098 | 40.078 | 44.956 | 47.867 | 50.942 | 51.996 | 54.938 | 55.845 | 58.951 | 58.693 | 63.546 | 65.381 | 69.723 | 74.922 | 78.964 | 83.798 |

| 37 Rb | 38 Sr | Y | Zr | Nb | Mo | Tc | Ru | Rh | Pd | Ag | Cd | In | Sn | Sb | Te | I | Xe |
| 85.468 | 87.62 | 88.906 | 91.224 | 92.906 | 95.94 | 98.76 | 101.07 | 101.96 | 106.42 | 107.86 | 112.41 | 114.82 | 118.71 | 121.76 | 126.90 | 131.29 |

| 55 Cs | 56 Ba | 57 Rf | 58 Db | 59 Sg | 60 Bh | 61 Hs | 62 Mt | 63 Lr | 64 Uu | 65 Uub | 66 Uup | 67 Uupp | 68 Uupp | 69 Uuppp | 70 Uupppl |
| 132.91 | 137.33 | 261 | 262 | 266 | 264 | 268 | 281 | 285 | 289 | 293 | 297 | 301 | 305 | 310 | 315 |

* Lanthanide series

| 57 La | 58 Ce | 59 Pr | 60 Nd | 61 Pm | 62 Sm | 63 Eu | 64 Gd | 65 Tb | 66 Dy | 67 Ho | 68 Er | 69 Tm | 70 Yb | 71 Lu |
| 138.91 | 140.11 | 140.91 | 144.24 | 145 | 150.36 | 151.96 | 157.25 | 158.92 | 162.50 | 164.93 | 167.26 | 172.04 | 174.97 |

# Actinide series

| 89 Ac | 90 Th | 91 Pa | U | 93 Np | 94 Pu | 95 Am | 96 Cm | 97 Bk | 98 Cf | 99 Es | 100 Fm | 101 Md | 102 No | 103 Lr |
| 227 | 228 | 229 | 230 | 231 | 232 | 233 | 234 | 235 | 236 | 237 | 238 | 239 | 240 | 241 | 242 | 243 | 244 | 245 | 246 | 247 | 248 | 249 | 250 | 251 | 252 | 253 | 254 | 255 | 256 | 257 | 258 | 259 | 260 | 261 | 262 |

* Lanthanide series

# Actinide series
PRELAB Problems for Lab #8: The Speed of Sound and Specific Heats of Gases

1. In this experiment, you will vary the height of the oil in a column of air, producing an air column with varying length. At certain lengths, acoustic resonances will occur for a given frequency of sound, \( f \). Given two different (consecutive) heights \( h_1 \) and \( h_2 \), of the oil in the column that produce resonance, derive an expression for the speed of sound, \( v \), in terms of \( f \), \( h_1 \) and \( h_2 \).

2. What are the resonant wavelengths, \( \lambda_n \), for standing sound waves in a small-diameter pipe of length \( L \) having one end open and the other end closed? Assume that there is a displacement node at the closed end of the pipe, and a pressure node at the open end, and write down a few words as to why you think these assumptions are reasonable. (Tipler's pages 517 and 518 are relevant to this problem.)

3. Assume that various traveling waves can exist in the same space, described by the equations

\[
\psi_1 (x,t) = A \sin \left( 7 \text{ m}^{-1} \cdot x - 520 \text{ sec}^{-1} \cdot t \right),
\]

\[
\psi_2 (x,t) = A \sin \left( 7 \text{ m}^{-1} \cdot x + 520 \text{ sec}^{-1} \cdot t \right),
\]

\[
\psi_3 (x,t) = A \sin \left( -7 \text{ m}^{-1} \cdot x - 520 \text{ sec}^{-1} \cdot t \right),\quad \text{and}
\]

\[
\psi_4 (x,t) = A \sin \left( -7 \text{ m}^{-1} \cdot x + 520 \text{ sec}^{-1} \cdot t \right).
\]

(a) Which waves are traveling in the direction of the positive \( x \) axis, and which in the negative \( x \) direction?

(b) What are the frequencies \( f \) and wavelengths \( \lambda \) of the waves? What are their speeds of propagation?

(c) What are the angular frequencies \( (\omega) \) and wave numbers \( (k) \) of the waves?

(d) Are any of the four wave functions identical with each other? Explain why or why not. \( (A \) is the same in each case.) You may want to consider the behavior of the four functions in the vicinity of \( x = 0, t = 0 \).

Note: It is irrelevant to answering these questions whether the \( \psi \)'s (and \( A \)) describe sound waves, the electric fields of a radio or light wave, or a quantum-mechanical wave function. Superposition, and the conditions leading to standing waves and resonance, are important aspects of any wave phenomenon.
Appendix A

Data Analysis with Excel

Computers are used for data analysis in any modern physics laboratory, and the Physics 103 lab is no exception. We have built our data analysis system around the program Excel, which is widely used on and off campus. We’ve added some Workshop Physics (WP) tools to make graphing data easier, and to let you do regression calculations with uncertainties, but otherwise we are using the standard, off-the-shelf software.1

If you are already familiar with Excel, great! If not, we’ll give brief instructions here. Like any software, it can be confusing at first, so don’t hesitate to ask your instructors and your fellow students for help. Play around with the program a bit to get comfortable with it.

A.1 Starting Things Up

- If the computer isn’t already on, turn it on and wait for it to boot up.

- If the Physics 103 window isn’t already open, double click on the Physics 103 icon to open it

- Double click on Excel with WPtools (look for the X logo) to get the program running.

A.2 Entering Data: a Simple Example

When Excel is started up, you need to open a spreadsheet to work in. If you are asked if you want to reopen WPtools, click No. Then go to File→New and click on OK to open a new Workbook. (If you wanted to open a pre-existing spreadsheet, you would use the File→Open menu command; if you want to save the new spreadsheet, use the File→Save menu command. Since we’ll be working with fairly small datasets, neither of these is really necessary for your lab work.)

Suppose you wish to record some \((x, y)\) data pairs in two columns of a spreadsheet. Go to Excel, and start entering the data in the upper left most cell (called A1). To do this, move the cursor to this cell and click on it with the left mouse button. Enter the first \(x\) data value

---

1Some online documentation for WPtools is at http://physics.dickinson.edu/~wp_web/wp_resources/Documentation.html

1Note: Menu commands are described as follows: File→Open means move the cursor to the word File on the line near the top of the screen, press and hold the left mouse button, drag the cursor down to the word Open, and release the button.
here, pressing Return when you are done. The cell below it (called A2) will automatically be selected next; enter the second x data value here. Work down the first data column in this way. If you need to go back and correct any of the numbers, simply move the cursor with the mouse, click on the relevant cell, and re-enter the number.

Once you’ve entered the first column of numbers, move the cursor to the top cell of the second column (cell B1) and click the left button to select it. Enter the first y data value. Press Return/Enter, and enter subsequent y data in the rest of the cells.

### A.3 Calculations in Excel

Now that your two columns of data are in the computer, select them. Do this by moving the cursor to the top left cell, pressing and holding the left mouse button, dragging the cursor to the lowest filled cell in the second column, and then releasing the mouse button. The block of numbers you entered will now be “selected”, indicated by a blue-grey color.

Go to the WPtools pull-down menu and select Linear Fit. Immediately Excel will display a plot of your data, along with the values and uncertainties of the best-fit line. Print out a copy of the results if desired.²

Sometimes you will want to transform your raw data in some way before plotting it. For example, you may have entered two columns of data as above, but you want to convert the y values from inches to meters. This is where a spreadsheet program becomes really handy. Select a blank cell somewhere on the sheet (cell C1 would be a good place). Instead of entering a number, enter the formula ‘=0.0254*B1’, and press Return. Excel will display the expected numerical value in cell C1, and it will also remember the formula. This is useful for two reasons, first, if you change the value in B1, the number in C1 will be automatically updated. Second, you can copy the formula in C1 to other cells, transforming the rest of column B using the same formula. To do this, first select cell C1. The cell becomes outlined, and note that there is a little square in the lower right corner of the outline. Move the cursor to this square, push and hold the left mouse button, drag the cursor down several cells, and release the mouse button. Voila! Excel will use the same formula to multiply all the cells in column B by 0.0254.

Excel can do much more complicated arithmetic. For example, you could use the formula =sqrt(A1) * B1 to take the square root of the values of cells in column A, multiply them by the values in column B, and put the result in some other column.

You might also want to take differences between the successive items in your data list. If you type into cell C2 the formula =B2-B1, and then use the little square to fill this formula into the cells B3, B4, etc., then you will obtain the differences in column C.

If you do a transformation like this, and then you want to do a plot or a curve fit, the columns of data you want to plot may not be adjacent to each other. No problem. Say you want to plot cells A1-A10 on the horizontal axis and cells C1-C10 on the vertical axis. First

---
²You must first “grab” the plot by left-clicking on an open area inside it. If the plot legends are obscuring the graph, drag them aside with the mouse. Your can add labels to your plot using the Edit labels option on the WPtools menu bar.
select A1-A10. (Go to cell A1, hold down the left button, drag the cursor to A10, then release the mouse button). Then **hold down the Ctrl key** and select C1-C10. Now both cell groups A1-A10 and C1-C10 will be selected, but not B1-B10. Run the WPTools→LinearFit routine, and you will get the plot you want.

### A.4 Accumulating Values via Excel Tricks

There will be times in the Physics 103 lab when you want to accumulate sums of a series of values. For example, you might have measured a series of time intervals,

\[
\begin{align*}
\Delta t_1 &= \text{interval between event 1 and event 2,} \\
\Delta t_2 &= \text{interval between event 2 and event 3,} \\
\Delta t_3 &= \text{interval between event 3 and event 4,} \\
\text{etc.}
\end{align*}
\]

You may wish to convert these into a continuous time scale. In other words, you may want to declare that \( t = 0 \) at the time of event 1, and then find

\[
\begin{align*}
time\text{ of event 2} &= \Delta t_1, \\
time\text{ of event 3} &= \Delta t_1 + \Delta t_2, \\
time\text{ of event 4} &= \Delta t_1 + \Delta t_2 + \Delta t_3, \\
\text{etc.}
\end{align*}
\]

This is easy to do. Say that \( \Delta t_1, \Delta t_2, \text{etc.} \), are in cells A1, A2, etc., and you want to put the accumulated times in column B. First put a 0 in cell B1 (since \( t = 0 \) for the first event). Then go to cell B2 and enter the formula \( =\text{SUM}($A$1:A1) \). The SUM function simply adds up the cells in the range specified.

The usefulness of the $ notation becomes apparent when you want to calculate the rest of the times. Select B2, move the cursor to the square in the lower righthand corner of the cell border, press and hold the left mouse button, drag the cursor down several cells, and release the button. The cells in column B are now filled with SUM functions, but in a special way: The \( $A$1 \) in the SUM function call remains the same in all the cells (because of the $), but the second part of the function call changes from A1 to A2 to A3, ... In other words, cell B3 now reads \( =\text{SUM}($A$1:A2) \), cell B4 reads \( =\text{SUM}($A$1:A3) \), and so on. These are exactly the formulae we want for the event time calculations, so column B is now filled with calculated values of \( t \).

### A.5 Further Notes about Workshop Physics Routines

- Use the WPtools→Polynomial Fit menu command, and set Order=2 to fit lines of the form \( y = c_0 + c_1 x + c_2 x^2 \).
- If you enter non-numerical text in the cell above each column of data, it will be used to label the horizontal and vertical axes on the plot.
• The fitting routines always use the first selected column for the horizontal \((x)\) points, and the second selected column for the vertical \((y)\) points.

• Empty rows are usually ignored (but partially-empty rows may corrupt the fit).

• To delete a plot, select it (move cursor to it and click once), then press the **Delete** key. To delete a column of the sheet, select the entire column (by clicking on the letter at the top) and use **Edit→Delete**.

• If data are modified after running a fit, the associated plot will be automatically updated, but the fit parameters will not be re-calculated. Usually it is best to delete both the old plot and fit parameters after updating data.
Appendix B

Estimation of Errors

While the subject of error analysis can become quite elaborate, we first emphasize a basic but quite useful strategy, discussed in secs. B.1-2. Then, we distinguish between random (or statistical) uncertainties and systematic uncertainties in sec. B.3. Random uncertainties follow the famous bell curve, as sketched in secs. B.4-5. The important distinction between the uncertainty on a single measurement, and the uncertainty on the average of many repeated measurements is reviewed in secs. B.7-7. The subject of propagation of errors on measured quantities to the error on a function of those quantities is discussed in sec. B.8.

B.1 67% Confidence

Whenever we make a measurement of some value \( v \), we would also like to be able to say that with 2/3 probability the value lies in the interval \([v - \sigma, v + \sigma]\). We will call \( \sigma \) the uncertainty or error on the measurement. That is, if we repeated the measurement a very large number of times, in about two thirds of those measurements the value \( v \) would be in the interval stated.

B.2 A Simple Approach

Repeat any measurement three times, obtaining a set of values \( \{v_i\}, i = 1, 2, 3 \). Report the average (mean),

\[
\bar{v} = \frac{1}{N} \sum_{i=1}^{N} v_i \quad \text{(for } N = 3),
\]

as the best estimate of the true value of \( v \), and the uncertainty \( \sigma \) as

\[
\sigma = \frac{v_{\text{max}} - v_{\text{min}}}{2}. \quad \text{(B.2)}
\]

If you take more than three measurements, you can still implement this procedure with the aid of a histogram. Divide the range of observed values of \( v \) into 5-10 equal intervals (called bins). Located the bin that contains each measurement, and draw a box one unit high above that bin. Stack the boxes on top of one another if more than one measurement falls in a bin. To estimate the error, determine the interval in \( v \) that contains the central 2/3 of the measurements, i.e., the central 2/3 of the boxes you just drew, and report the error as 1/2 the length of this interval.
B.3 Random and Systematic Uncertainties

The uncertainty in a measurement of a physical quantity can be due to intrinsic random uncertainty (colloquially: error) as well as to systematic uncertainty.

Random uncertainties lead to difference in the values obtained on repetition of measurements. Systematic uncertainties cause the measurement to differ from its ideal value by the same amount for all repetitions of the measurement.

Random uncertainties can arise from vibrations of the components of a set-up driven by random thermal fluctuations, random noise in the electronics, and/or many other small but uncontrolled effects including quantum fluctuations.

In principle, the effect of random uncertainties can be made as small as desired by repetition of the measurements, such that the dominant uncertainty is due to systematic effects (which can only be reduced by designing a better measurement apparatus).

B.4 The Bell Curve

In many cases when a measurement is repeated a large number of times the distribution of values follows the bell curve, or Gaussian distribution:

\[
P(v) = \frac{e^{-(v-\mu)^2/2\sigma^2}}{\sqrt{2\pi}\sigma},
\]  

where \( P(v)dv \) is the probability that a measurement is made in the interval \([v, v + dv]\), \( \mu \) is true value of the variable \( v \), and \( \sigma \) is the standard deviation or uncertainty in a single measurement of \( v \). See Figure B.1.

![Figure B.1: The probability distribution measurements of a quantity with true value \( \mu \) and Gaussian uncertainty \( \sigma \) of a singe measurement. About 68% of the measurements would fall in the interval between \( \mu - \sigma \) and \( \mu + \sigma \), and 95% would fall in the interval \( \mu \pm 2\sigma \).](image)

The Table lists the confidence that a single measurement from a Gaussian distribution falls within various intervals about the mean. If the 100 students in Ph103 each make 100
Table B.1: The probability (or confidence) that a measurement of a Gaussian-distributed quantity falls in a specified interval about the mean.

<table>
<thead>
<tr>
<th>Interval</th>
<th>Confidence</th>
</tr>
</thead>
<tbody>
<tr>
<td>±σ</td>
<td>68%</td>
</tr>
<tr>
<td>±2σ</td>
<td>95%</td>
</tr>
<tr>
<td>±3σ</td>
<td>99.7%</td>
</tr>
<tr>
<td>±4σ</td>
<td>99.994%</td>
</tr>
</tbody>
</table>

measurements during these lab sessions, then 10,000 measurements will be taken in all. The Table tells us that if those measurements have purely Gaussian ‘errors’, then we expect one of those measurements to be more than 4σ from the mean.

B.5 Estimating Uncertainties When Large Numbers of Measurements Are Made

One can make better estimates of uncertainties if the measurements are repeated a larger number of times. If $N$ measurements are made of some quantity resulting in values $v_i, \ i = 1, \ldots N$ then the mean is, of course,

$$\bar{v} = \frac{1}{N} \sum_{i=1}^{N} v_i,$$  

(B.4)

and the standard deviation of the measurements is

$$\sigma = \sqrt{\frac{1}{N-1} \sum_{i=1}^{N} (v_i - \bar{v})^2}.$$  

(B.5)

Calculus experts will recognize that the operation $(1/N) \sum_{i=1}^{N}$ becomes $\int P(v) \, dv$ in the limit of large $N$. Then, using the Gaussian probability distribution (B.3) one verifies that

$$\bar{v} = \langle v \rangle = \int_{-\infty}^{\infty} v P(v) \, dv, \quad \text{and} \quad \sigma^2 = \langle (v - \bar{v})^2 \rangle = \int_{-\infty}^{\infty} (v - \bar{v})^2 P(v) \, dv.$$  

(B.6)

B.6 The Uncertainty on Mean of a Uniformly Distributed Quantity

Not all measurable quantities follow the Gaussian distribution. A simple example is a quantity with a uniform distribution, say with values $v$ equally probable over the interval $[a, b]$. It is clear that the average measurement would be $(a + b)/2$, but what is the uncertainty of the measurement? If we adopt the simple prescription advocated in secs. B.2 we would
report the uncertainty as \((b - a)/3\) since \(2/3\) of the time the measurement would fall in an interval \(2(b - a)/3\) long. If instead we use the calculus prescription for \(\sigma\) given in eq. (B.6) we find that

\[
\sigma = \frac{b - a}{\sqrt{12}} = \frac{b - a}{3.46},
\]

which result is often used by experts.

### B.7 The Uncertainty in the Mean

Thus far we have considered only the uncertainty or spread in measured values of some quantity \(v\). A related but different question is: what is the uncertainty on our best estimate of \(v\) (which is just the mean value of our measurements, \(\bar{v} = (1/N) \sum v_i\))?

The uncertainty on the mean \(\bar{v}\) is surely less that the uncertainty, \(\sigma\), on each measurement \(v_i\). Indeed, the uncertainty on the mean is given by

\[
\sigma_{\bar{v}} = \frac{\sigma}{\sqrt{N}},
\]

where \(\sigma\) is our estimate of the measurement error obtained from one of the methods sketched previously.

Appendix C illustrates eq. (B.8) using measurements of \(g\) from past Ph103 labs.

### B.8 The Uncertainty on a Function of Several Variables (Propagation of Error)

In many cases we are interested in estimating the uncertainty on a quantity \(f\) that is a function of measured quantities \(a, b, ... c\). If we know the functional form \(f = f(a, b, ...c)\) we can estimate the uncertainty \(\sigma_f\) using some calculus. As a result of our measurements and the corresponding ‘error analysis’ we know the mean values of \(a, b, ... c\) and the error estimates \(\sigma_a, \sigma_b, ... \sigma_c\) of these means. Our best estimate of \(f\) is surely just \(f(a, b, ...c)\) using the mean values.

To estimate the uncertainty on \(f\) we note that the change in \(f\) due to small changes in \(a, b, ... c\) is given by

\[
\Delta f = \frac{\partial f}{\partial a} \Delta a + \frac{\partial f}{\partial b} \Delta b + ... + \frac{\partial f}{\partial c} \Delta c.
\]

(B.9)

If we just averaged this expression we would get zero, since the ‘errors’ \(\Delta a, ... \Delta c\) are sometimes positive, sometimes negative, and average to zero. Rather, we square the expression for \(\Delta f\), and then average.

\[
\Delta f^2 = \left( \frac{\partial f}{\partial a} \right)^2 \Delta a^2 + ... + \left( \frac{\partial f}{\partial c} \right)^2 \Delta c^2 + ... + 2 \frac{\partial f}{\partial a} \frac{\partial f}{\partial c} \Delta a \Delta c + ...
\]

(B.10)

On average the terms with factors like \(\Delta a \Delta c\) average to zero (under the important assumption that parameters \(a, b, ... c\) are independent). We identify the average of the squares of
the changes relative to the mean values as the squares of the errors: \( \langle \Delta a^2 \rangle = \sigma_a^2 \), etc. This leads to the prescription

\[
\sigma_f^2 = \left( \frac{\partial f}{\partial a} \right)^2 \sigma_a^2 + \ldots + \left( \frac{\partial f}{\partial c} \right)^2 \sigma_c^2 + \ldots \quad (B.11)
\]

Some useful examples are

\[
f = a \pm b \pm \ldots \pm c \quad \Rightarrow \quad \sigma_f = \sqrt{\sigma_a^2 + \sigma_b^2 + \ldots + \sigma_c^2}, \quad (B.12)
\]

and

\[
f = a^l b^m \ldots c^n \quad \Rightarrow \quad \frac{\sigma_f}{f} = \sqrt{l^2 \left( \frac{\sigma_a}{a} \right)^2 + m^2 \left( \frac{\sigma_b}{b} \right)^2 + \ldots + n^2 \left( \frac{\sigma_c}{c} \right)^2}, \quad (B.13)
\]

where \( l, m \) and \( n \) are constants that may be negative.

For more detailed and rigorous analyses one can consult, for example:


Appendix C

Standard Deviation of the Mean of $g$

Suppose you make $N$ repeated measurements of a quantity $g$, such as the acceleration due to gravity. How well is the value of $g$ determined by these measurements?

For example, during the 2006 sessions of Ph103 Lab 6 a total of 37 different measurements of $g$ were made, as shown in the histogram Fig. C.1.

![Histogram of 37 measurements of $g$](image)

Figure C.1: Histogram of the values of $g$ measured in the 2006 Ph103 Lab 3. The horizontal axis is $g$, and the vertical axis is the number of times a value of $g$ was reported to lie with the range of $g$ corresponding to the width of a vertical bar.

A histogram is a graph containing $M$ vertical bars in which the height of a bar indicates the number of data points whose value falls within the corresponding “bin”, i.e., within the interval $[g_j - \Delta/2, g_j + \Delta/2]$, where $g_j, j = 1, M$ and the centers of the $M$ bins and $\Delta$ is the bin width. One can make a histogram of a data set $\{g_i\}$ using Excel/Tools/Data Analysis/Histogram. Enter the data $\{g_i\}$ in one column of an Excel spreadsheet. Click on the Input Range: box of the Histogram window; then click and hold the left mouse button on the first data point, and drag the mouse to the last data point to enter the cell addresses of the data. Click on Chart Output and then OK to create a basic histogram. If the number/spacing of “bins” chosen by Excel is awkward, fill a new column with a linear series of 5-10 steps that begins near the lowest $g_i$ and ends near the highest; create a new histogram with the Excel addresses of the first and last elements of the bin list in the box Bin Range:..
The mean value $\bar{g}$ is calculated according to

$$\bar{g} = \frac{\sum_{i=1}^{N} g_i}{N},$$  \hspace{1cm} (C.1)

and was found to be $\bar{g} = 939.5 \text{ cm/s}^2$ for the data shown in Fig. C.1.

The distribution of the value of $g$ is approximately Gaussian, and the standard deviation of this distribution is calculated according to

$$\sigma_g = \sqrt{\frac{\sum_{i=1}^{N} (g_i - \bar{g})^2}{N - 1}},$$  \hspace{1cm} (C.2)

with the result that $\sigma_g = 9.1 \text{ cm/s}^2$.

The standard deviation $\sigma_g$ is a good estimate of the uncertainty on a single measurement of $g$. However, after 37 measurements of $g$, the uncertainty on the mean value $\bar{g}$ is much smaller than $\sigma_g$.

An important result of statistical analysis is that the standard deviation (i.e., the uncertainty) of the mean of the $N$ measurements is related to the standard deviation of the distribution of those measurements by,

$$\sigma_{\bar{g}} = \frac{\sigma_g}{\sqrt{N}}.$$  \hspace{1cm} (C.3)

For the data shown in Fig. C.1, where $N = 37$, we obtain

$$\sigma_{\bar{g}} = \frac{9.1}{\sqrt{37}} = 1.5 \text{ cm/s}^2.$$  \hspace{1cm} (C.4)

That is, we can report the result of all 37 measurements of $g$ as

$$g = 979.5 \pm 1.5 \text{ cm/s}^2.$$  \hspace{1cm} (C.5)

As a check that eq. (C.3) is valid, we can analyze the data another way. Namely, we can first calculate the means $\bar{g}_i$ for the 5 different sessions of Ph103 Lab 3. Then, we can make a histogram of these 5 values, as shown in Fig. C.2.

The mean of the 5 means is 979.6 cm/s$^2$, which is essentially identical to the mean of the 37 individual measurements of $g$. The standard deviation of the 5 means shown in Fig. C.2 is calculated to be 1.6 cm/s$^2$, which is essentially identical to the previous calculation (C.4) of the standard deviation of the mean.

**Concluding Remarks:** If $N$ were much larger than what we have here, the histogram C.1 would approach the Gaussian distribution (the bell-curve) shown in Appendix B. The peak in the histogram would be very close to the mean value $\bar{g}$ of the measurements, which represents the best estimate of $g$ from the data. The standard deviation $\sigma_g \approx \text{width}/2$ is a measure of the uncertainty of a single measurement,$^1$ while $\sigma_g/\sqrt{N}$ is the uncertainty on the best estimate $\bar{g}$.

---

$^1$Strictly speaking, the full width at half maximum of a Gaussian distribution is $2.35\sigma_g$. 

Figure C.2: Histogram of the mean values of $g$ measured in the 5 sessions of Ph103 Lab 6 in 2006.
Appendix D

Polynomial Fits in WPtools

D.1 Polynomial Regression

In this technical Appendix we sketch the formalism used in the polynomial regression method for fitting data. This is a generalization of the method of linear regression.

We start with a set of data \((x_j, y_j), \ j = 1, \ldots, m\), and we wish to fit these data to the \(n\)th-order polynomial

\[
y(x) = \sum_{i=0}^{n} a_i x^i.
\]

(D.1)

In general each measurement \(y_j\) has a corresponding uncertainty \(\sigma_j\). That is, if the measurements were repeated many times at coordinate \(x_j\) the values of \(y_j\) would follow a gaussian distribution of standard deviation \(\sigma_j\). We indicate in sec. D.2 how the program WPtools proceeds in the absence of input data as to the \(\sigma_j\).

Because of the uncertainties in the measurements \(y_j\) we cannot expect to find the ideal values of the coefficients \(a_i\), but only a set of best estimates we will call \(\hat{a}_i\). However, we will also obtain estimates of the uncertainties in these best-fit parameters which we will label as \(\sigma_{\hat{a}_i}\).

The best-fit polynomial is then

\[
\hat{y}(x) = \sum_{i=0}^{n} \hat{a}_i x^i.
\]

(D.2)

The method to find the \(\hat{a}_i\) is called least-squares fitting as well as polynomial regression because we minimize the square of the deviations. We introduce the famous chi square:

\[
\chi^2 = \sum_{j=1}^{m} \frac{(y_j - \hat{y}(x_j))^2}{\sigma_j^2} = \sum_{j=1}^{m} \frac{(y_j - \sum_{i=0}^{n} \hat{a}_i x_j^i)^2}{\sigma_j^2}.
\]

(D.3)

Fact: \(\exp(-\chi^2/2)\) is the (un-normalized) probability distribution for observing a set of variables \(\{y_j(x_j)\}\) supposing the true relation of \(y\) to \(x\) is given by eq. (D.2).

A great insight is that \(\exp(-\chi^2/2)\) can be thought of another way. It is also the (un-normalized) probability distribution that the polynomial coefficients have values \(a_i\) when their best-fit values are \(\hat{a}_i\) with uncertainties due to the measurements \(\{y_j\}\). Expressing this in symbols,

\[
\exp(-\chi^2/2) = \text{const} \times \exp \left(- \sum_{k=0}^{n} \sum_{l=0}^{n} \frac{(a_k - \hat{a}_k)(a_l - \hat{a}_l)}{2\sigma_{kl}^2} \right),
\]

(D.4)
or equivalently
\[ \chi^2/2 = \text{const} + \sum_{k=0}^{n} \sum_{l=0}^{n} \frac{(a_k - \hat{a}_k)(a_l - \hat{a}_l)}{2\sigma_{kl}^2}. \] (D.5)

The uncertainty on \( \hat{a}_k \) is \( \sigma_{kk} \) in this notation. In eqs. (D.4) and (D.5) we have introduced the important concept that the uncertainties in the coefficients \( \hat{a}_k \) are correlated. That is, the quantity \( \sigma_{kl}^2 \) is a measure of the probability that the values of \( a_k \) and \( a_l \) both have positive fluctuations at the same time. In fact, \( \sigma_{kl}^2 \) can be negative indicating that when \( a_k \) has a positive fluctuation then \( a_l \) has a correlated negative one.

One way to see the merit of minimizing the \( \chi^2 \) is as follows. According to eq. (D.5) the derivative of \( \chi^2 \) with respect to \( a_k \) is
\[ \frac{\partial \chi^2/2}{\partial a_k} = \sum_{l=0}^{n} \frac{a_l - \hat{a}_l}{\sigma_{kl}^2}, \] (D.6)
so that all first derivatives of \( \chi^2 \) vanish when all \( a_l = \hat{a}_l \). That is, \( \chi^2 \) is a minimum when the coefficients take on their best-fit values \( \hat{a}_i \). A further benefit is obtained from the second derivatives:
\[ \frac{\partial^2 \chi^2/2}{\partial a_k \partial a_l} = \frac{1}{\sigma_{kl}^2}. \] (D.7)

In practice we evaluate the \( \chi^2 \) according to eq. (D.3) based on the measured data. Taking derivatives we find
\[ \frac{\partial \chi^2/2}{\partial \hat{a}_k} = \sum_{j=1}^{m} \left( \frac{y_j - \sum_{i=0}^{n} \hat{a}_i x_j^i}{\sigma_j^2} \right) \left( \frac{-x_j^k}{\sigma_j^2} \right) = \sum_{j=1}^{m} \frac{\hat{a}_i x_j^i x_j^k}{\sigma_j^2} - \sum_{j=1}^{m} \frac{y_j x_j^k}{\sigma_j^2}, \] (D.8)
and
\[ \frac{\partial^2 \chi^2/2}{\partial \hat{a}_k \partial \hat{a}_l} = \sum_{j=1}^{m} \frac{x_j^k x_j^l}{\sigma_j^2} = M_{kl}. \] (D.9)

To find the minimum \( \chi^2 \) we set all derivatives (D.8) to zero, leading to
\[ \sum_{i=0}^{n} \sum_{j=1}^{m} \frac{x_j^i x_j^k}{\sigma_j^2} \hat{a}_i = \sum_{j=1}^{m} \frac{y_j x_j^i}{\sigma_j^2} \equiv V_k. \] (D.10)
Using the matrix \( M_{kl} \) introduced in eq. (D.9) this can be written as
\[ \sum_{i=0}^{n} M_{ik} \hat{a}_i = V_k. \] (D.11)
We then calculate the inverse matrix \( M^{-1} \) and apply it to find the desired coefficients:
\[ \hat{a}_k = \sum_{l=0}^{n} M_{kl}^{-1} V_l. \] (D.12)
Comparing eqs. (D.7) and (D.9) we have
\[ \frac{1}{\sigma_{kl}^2} = M_{kl}. \] (D.13)
The uncertainty in best-fit coefficient \( \hat{a}_i \) is then reported as
\[ \sigma_{\hat{a}_i} = \sigma_{ii} = \frac{1}{\sqrt{M_{ii}}}. \] (D.14)
D.2 Procedure When the $\sigma_j$ Are Not Known

This method can still be used even if the uncertainties $\sigma_j$ on the measurements $y_j$ are not known. When the functional form (D.1) correctly describes the data we claim that on average the minimum $\chi^2$ has value $m - n - 1$.\(^1\) To take advantage of this remarkable result we suppose that all uncertainties $\sigma_j$ have a common value, $\sigma$. Then

$$\chi^2 = \sum_{j=1}^{m} \left[ \frac{y_j - \hat{y}(x_j)}{\sigma^2} \right]^2 \approx m - n - 1,$$  \hspace{1cm} (D.15)

so that

$$\sigma_j = \sigma = \sqrt{\frac{\sum_{j=1}^{m} \left[ y_j - \sum_{i=0}^{n} \hat{a}_i x_i^j \right]^2}{m - n - 1}}.$$  \hspace{1cm} (D.16)

In practice it appears that the error estimates from this procedure are more realistic if a fit is made using a polynomial with one order higher than needed for a ‘good’ fit to the data.

Using eq. (D.16) as the estimate of the uncertainty $\sigma$ on each of the measurements $y_j$, the matrix $M_{kl}$ of eq. (D.9) becomes

$$M_{kl} = \frac{m - n - 1}{\sum_{j'=1}^{m} \left[ y_j - \sum_{i'=0}^{n} \hat{a}_{i'} x_i^{j'} \right]^2} \sum_{j=1}^{m} x_j^k x_j^l.$$  \hspace{1cm} (D.17)

The estimate (D.14) of the uncertainty on the fit coefficient $\hat{a}_i$ is now given by

$$\sigma_{\hat{a}_i} = \frac{1}{\sqrt{M_{ii}}} = \sqrt{\frac{\sum_{j'=1}^{m} \left[ y_j - \sum_{i'=0}^{n} \hat{a}_{i'} x_i^{j'} \right]^2}{(m - n - 1) \sum_{j=1}^{m} x_j^{2i}}}.$$  \hspace{1cm} (D.18)

When WPtools performs a polynomial regression it generates a plot of the data points and the best-fit curve, along with numerical values of various parameters associated with the fit. Figure D.1 gives an example of a fit to a set of 8 data points of the form $y = x^2$. The fit is to the form $y = a_0 + a_1 x + a_2 x^2$. The fit coefficients are $a_0 = -0.4107$, $a_1 = -0.3274$ and $a_2 = 1.1964$. The uncertainties (standard errors) on the fit coefficients are reported as $SE(a_0) = 4.0070$, $SE(a_1) = 2.0429$ and $SE(a_2) = 0.2216$, as calculated according to eq. (D.18). Note that the uncertainties on coefficients $a_1$ and $a_2$ are larger than the coefficients themselves, which tells us that these coefficients are indistinguishable from zero.

Also indicated on the plot are the values $R^2 = 0.9915$ and $\sigma = 2.8721$. The latter is the uncertainty in the data points $\{y_j\}$, calculated according to eq. (D.16) with $m = 8$ and $n = 2$. The quantity $R^2$ is defined by

$$R^2 = \frac{\sum_{j=1}^{m} \left[ \hat{y}(x_j) - \overline{y} \right]^2}{\sum_{j=1}^{m} \left[ y(x_j) - \overline{y} \right]^2},$$  \hspace{1cm} (D.19)

where the average $\overline{y} = \sum_{j=1}^{m} y(x_j)/m$. This is a measure of the "goodness of fit". If the fit is perfect then $\hat{y}_j = y_j$ for all $j$ and $R^2 = 1$. It is not obvious, but $R^2 \leq 1$ always. The extreme case of $R^2 = 0$ occurs when the fit has the trivial form $\hat{y}(x) = \overline{y}$ for all $x$, which in general is a bad fit. The qualitative conclusion is that if $R^2$ is not close to 1, the fit results are to be regarded with suspicion.

\(^1\)The whole fitting procedure does not make sense unless there are more data points ($m$) than parameters ($n + 1$) being fitted.
Series1(X) = a_0 + \sum a_n(X)^n

Series1(X) = a_0 + a_1(X) + a_2(X)^2

\begin{align*}
a_0 &= -0.4107 \\
a_1 &= -0.3274 \\
a_2 &= 1.1964
\end{align*}

SE(a_0) = 4.0070
SE(a_1) = 2.0429
SE(a_2) = 0.2216

R^2 = 0.9915
\sigma = 2.8721

Figure D.1: Sample plot from WPtools Polynomial Fitting.